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V O T I R D 1 Introduction

1 Introduction
1.1 Votiro Technology

Votiro secures your organization by positively selecting safe elements of each file and
email delivered to your network.

Votiro is unlike traditional detection-based file security solutions that scan for suspicious
elements and block some malicious files from entering your organization. Instead, threats
to your network from unknown and malicious elements of a file are simply not included in
the file delivered by Votiro. This results in every file entering your organization's network
being 100% safe.

Votiro protects your organization from all sources of file exploit attempts that are
processed through various channels such as email, web uploads, web downloads, or any
supported custom application.

Votiro is enterprise-oriented, fast to deploy, easy to integrate, and seamless. It also
eliminates the reliance on users' assessment of the safety of incoming emails or files.

Votiro implements a multi-layer security mechanism that integrates several critical
components to eliminate cyber threats that attempt to penetrate an organization.

True Type Detection

True Type Detection (TTD) determines a file’s type by comparing the extension associated
with the file with the specifications dictated by the vendor for that file type. For example,
Microsoft Corporation has specified that a file with the extension .docx is a Microsoft
Word document. In order for Word to open the file correctly, the file attributes must meet
specific criteria designated by Microsoft. TTD verifies the criteria set by Microsoft are met
before the file is processed.

When TTD is used in the Votiro solution and specified by the applied policy, files with
content that does not match the file extension criteria are considered as "suspicious fake
files".

1.2 System Architecture and Data Flow in Votiro

A general view of the Votiro product in relation to other key elements in the network is
provided in the following diagram:
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1.3

1 Introduction

Web Portal Processed
Inbound File

External Person :
E Secure File Gateway with Lisar

Positive Selection Engine

User Downloads User Downloads

Data flows between Positive Selection® Engine, Votiro API Integration, Votiro On-prem for
Email and Votiro On-prem for File Transfer. Communication consists of multiple bi-
directional messages that include queuing, tracking, file transfers and reports.

Votiro's Positive Selection® Engine is at the heart of the Votiro solution. The Positive
Selection® Engine is provided with a front-end Management Dashboard that is used for the
following:

Monitoring and analyzing positive selection activity in the Positive Selection®
Engine.

Creating and editing positive selection policies that are regularly updated in the
Positive Selection® Engine.

Storing metadata that describes the files, along with the original and processed files
themselves for incident management identification.

The Votiro product image is based on Ubuntu 22.04 and hardened according to CIS Server
Level 1.

Positive Selection® Engine

Votiro's Positive Selection® Engine is at the heart of the Votiro solution. The Positive
Selection® Engine keeps only what belongs instead of searching for what does not belong.

Unlike detection-based file security solutions that scan for suspicious elements and block
some malicious files, Positive Selection singles out only the safe elements of each file,
ensuring every file that enters your organization is 100% safe.

Positive Selection processing involves four steps:
Step 1: Unknown file is received into your organization.
Step 2: The file is dissected into content, templates and objects.
Step 3: The file is rebuilt using content on top of a safe file template.

Step 4: Delivery of 100% safe file into your organization.

Votiro CyberSec Ltd. Proprietary Page 7
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An example of Votiro's Positive Selection® Engine processing a file is provided in the
following diagram:

Step 1 Step 2 Step 4

oy ) . -
= =
1.4 Supported File Types

The File Types table lists the file types and attributes supported by Votiro On-prem. The
information is arranged according to the categories that appear in the Action by File Type
area of the Policies page in the Votiro Management Dashboard.

Types marked with » are scanned by the Positive Selection® Engine and their true
file type is verified based on their structure. The files are not modified by this
process. To allow files that have only detection, go to the Policies dashboard and
create an exception under Other files. For more information, see Adding Policy

Exceptions.

Types marked with ** are obsolete. They are not recommended as filters in a
production environment. Support for these types might be discontinued in a later

version.
Table 1 File Types

File Type in ) . Main
FileT Family T

Management ne Type amfly Type Extension
PDF Adobe PDF pdf

PDF
XFA Xfa Files pdf

Votiro CyberSec Ltd. Proprietary Page 8
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File Type in
Management

Image

Binary

Votiro CyberSec Ltd. Proprietary

File Type

Animated GIF
BMP

EMF

GIF

HEIF ~

JPEG

PNG

Portable Gray
Map Image File

X% A

PPM File ** ~
SVG

TIF

WDP

WMF

ICO

PCX

WEBP

Binary File ~

Executable

Family Type

Raster Image Files
Raster Image Files
Vector Image Files
Raster Image Files

Raster Image Files
Raster Image Files

Raster Image Files

Raster Image Files

Raster Image Files
Vector Images Files
Raster Image Files
Raster Image Files
Vector Image Files
Icon Image Files
Picture Exchange Files
Raster Image Files

Any Binary Files

Any Binary Files

1 Introduction

Main
Extension
gif

bmp

emf

gif

heic, heif

jpeg, jpg,
emf, jp2

png, emf

pgm

ppm
svg

tif, tiff
Wdp
wmf
ico

pcx
webp
dat, db

exe, com, dll,
pif, sfx, msu,
msp, msi, mo
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File Type in
Management

Archive

RTF

Email

Votiro CyberSec Ltd. Proprietary

File Type

Bzip2 ~
7Z File
CAB file A
GZFile
GZIP File

InstallShield
CAB file »

LZH File ~
RAR File
Tar File

VMware Virtual
Machine Disk »

Xz~

ZIP File

RTF Files
Calendar File
DAT File ** ~
EML File

Encrypted EML
File ~

HTML Body ~

HTML
Attachments

MSG File

PST ~

PST ANSI ~
RPMSG Files ~

TNEF Calendar
Files **

TNEF File **
VCF File

Family Type

Single compressed file
Archives
Archives
Archives

Archives
Archives

Archives
Archives

Archives
Archives

Single compressed file
Archives

RTF Files

Calendar Files

EML Files

EML Files

EML Files
HTML Files
HTML Files

MSG Files
PST Files
PST Files

Restricted Permission Message Fles

EML Files

EML Files

Contact Files

1 Introduction

Main
Extension

bz2

7z

cab, wsp
gz

gzip

cab

Izh
rar, rar5

tar
vmdk

Xz
zip

rtf

ics

dat

eml, tmp

eml, tmp,
p7s, p7m

html, htm
html, htm

msg
pst
pst

rpmsg
eml

eml

vcf
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File Type in . . Main

File T Family T
Management L L L Extension
Microsoft Office | Excel Microsoft Office xls, xlIt, xml
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File Type in
Management
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File Type

Excel (2007-
2010)

Excel95 Files
Excel Binary

Excel on xml
format ~

Excel Template

Excel with
Macros

ExcelXML

Internal Office
XML A

Macro File ~

Obsolete Office
Files ** ~

Power Point

Power Point
(2007-2010)

Power Point
Slide (2007-
2010)

Power Point
Slide with
Macros (2007-
2010)

Power Point
Template

Power Point
Template with
Macros

Power Point with
Macros

PowerPointXML

N

Printer Settings

Project ~

Family Type

Microsoft Office

Office

Microsoft Office Binary Files
Malformed Microsoft Office
Microsoft Office

Microsoft Office with Macros
Microsoft Office

Text Files

Office Macro Files

Microsoft Office

Microsoft Office

Microsoft Office

Microsoft Office

Microsoft Office with Macros

Microsoft Office

Microsoft Office with Macros

Microsoft Office with Macros

Microsoft Office

Microsoft Office Embedded Files
Microsoft Office

1 Introduction

Main
Extension

xlsx

xls

xlsb

xls

xltx, xltm
xlsm

xml

xml, xml.rels,
rels, vml

bin
Wi

pPt, pps,
ppsx, xml,
pot

pptx

sldx

sldm

potx

potm

pptm

xml
bin
mpp
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File Type in

Management

Text

Apple iWork

Votiro CyberSec Ltd. Proprietary

File Type

Unknown Ole
Object (see
note)

Visio

Visio (2007-
2010)

Visio with
Macros

Word

Word (2007-
2010)

Word Pre-2007

Template

Word Template
Word Template

with Macros

Word with
Macros

WordXML
INI ~

Text ~

Postscript File ~

XML

JSON

csv

PAGES »
PAGES.ZIP ~
NUMBERS ~

NUMBERS.ZIP »

KEY ~
KEY.ZIP ~

Family Type

OLE Object

Microsoft Office

Microsoft Office

Microsoft Office with Macros
Microsoft Office

Microsoft Office

Microsoft Office
Microsoft Office

Microsoft Office

Microsoft Office with Macros

Microsoft Office

Configuration Files

Text Files

Text Files

Text Files

JavaScript Object Notation Files
Comma-Separated Values Files
Apple text document

Apple text zip document

Apple spreadsheet file

Apple spreadsheet zip file
Apple Keynote file

Apple Keynote zip file

1 Introduction

Main
Extension

bin

vsd

vsdx

vsdm
doc

docx

dot
dotx

dotm

docm

xml

ini

txt

ps

xml

json

csv
pages
pages.zip
numbers
numbers.zip
key
key.zip
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:Len::_:,;z;:nt File Type Family Type r):::nsion
Bmp Ole Object ' OLE Object bin
Docm Ole Object  OLE Object bin
Docx Ole Object | OLE Object bin
Dotx Ole Object ' OLE Object bin
Pdf Ole Object | OLE Object bin
Pptm Ole Object ' OLE Object bin
Ole Pptx Ole Object | OLE Object bin
Slide Ole Object | OLE Object bin
g'l'jzz Ole OLE Object bin
Z':ggzo'e OLE Object bin
Xls Ole Object | OLE Object xls
Xlsx Ole Object | OLE Object bin
AVI Audio Video Interleave avi
DAT Generic media dat
MPEG MPEG video mpeg, mpg
WAV Waveform Audio File Format wav
WMV Windows Media Video wmv
MP3 MPEG-1 Audio Layer-3 mp3
Media MP4 MPEG-4 multimedia mp4
M4A MPEG-4 audio m4a
MOV Apple QuickTime Movie mov
3GP 3GPP multimedia 3gp
M4V Apple MPEG-4 m4v
MKV Matroska Video mkv
WMA Windows Media Audio wma
MXF Material Exchange Format File mxf
Open Office ODS Calc Spreadsheet File ods
oDT OpenOffice Document file odt
CRT A Security Certificate File crt
Certificate CRL~ Certificate Revocation List crl
CER AN Third-party Certificate Authority File cer
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File Type in . Main
File Type Family Type .
Management o L Extension
DWF ~ AutoDesk Design Web Format File dwf
DWG AutoCAD Drawing File dwg
DWS AutoCAD Drawing Verification File dws
DWT AutoCAD Drawing Template File dwt
AutoCAD
DXF AutoCAD Drawing Exchange Format File dxf
Jww Java Web-Workflows Data file jww
P21 File Express STEP Data Model Files p21
SFC File Super Famicom Video Game Files sfc
JTD Ichitaro Document file jtd
Ichitaro
JTDC Ichitaro Compressed Document file jtdc
DocuWorks XDW ~ DocuWorks Image file xdw
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File Type in . . Main

File T Family T
Management re lype amty Type Extension
Other ACIS Solid Model File ~ CAD Files sat
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File Type in . . Main
FileT Family T

Management e L Extension
Adobe Air *¥* ~ Adobe air

Votiro CyberSec Ltd. Proprietary Page 17
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File Type in
Management
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File Type

CD Audio Track Shortcut
File ** ~

CsSs A

Data Files
DB Files ~

Dicom File

Embedded Macro Files
Empty File ~

Equation Ole Object ~

Excel2, Excel3, Excel4,
Excel5”

HWP 3.0 File ~
INF File ~

Initial Graphics
Specification File ~

JAR A
LabView ** »

Mac AppleSingle encoded

N

Mac AppleDouble encoded

N

Mac OS X folder
information ~

Mac OS X crash log
MHT File ~

MST files ** ~

p7s

Parasolid model File ** ~
Pcx File ~

Pgp File »
PowerPoint95 File ~
PreR14Dwg File »
PreWord97 File ~
PSD File ~

RPT kX A

Family Type

Media Files

CSS

Model Item Data Files

Database Files

Dicom Files
Embedded File
None

OLE Object
Office Files

Hancom Files

INF Files
CAD Files

JAR Files
LabView

Mac OS Files

Mac OS Files

Mac OS Files

Mac OS Files

MHT Files
Installer Setup File
Digital Signatures
CAD Files

CAD Files
Encrypted Files
Unsupported Files
CAD Files
Unsupported Files
Photoshop Files
RPT Files

1 Introduction

Main
Extension

cda

Ccss
data

dbf, npa, dbt, wnd,
tab, mdb

dcm

bin

bin
xls

hwp

inf

igs

jar, jarxx
Vi

._" prefix

._" prefix

ds_store

crash
mht
mst
p7s
x_t,x b
pcx
pap
ppt
dwg
doc
psd
rpt
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File Type in

File Type

Management

RSP File *¥* ~

Script A

Shortcut File ~

Solution User Option File

Xk A
SQL File ** ~
Unrecognized ~

VCF ~

Anomalies and Limitations

Family Type

PLC Files

Batch Files

Shortcut Files
Visual Studio Files

SQL Files
Any Binary Files

Exchange

1 Introduction

Main
Extension

rsp

bat, js, php, cmd, vbs,

reg, pl, Ink, py, asp,
psi

url

Suo

sql

vcf

Processing files for positive selection so you only receive secure content occasionally
results in some known anomalies and limitations. These include:

Unknown Ole Objects: both generic and unknown Ole objects are handled.

Generic Ole objects will be processed, and unknown Ole objects will be blocked.

File names with more than 101 non-English characters may not be included.

As you can see, the file size limitations are currently significant sizes:

Archives - 2 GB
CSV-2GB

Raster images - 100 MB
Text - 100 MB

PDF - 700 MB

EML - 64 MB

ICS-5 MB

Office - 50 MB
ExcelX-1GB
PowerPointX - 1 GB
WordX - 750 MB

Visio - 1 GB

Vector images - 10 MB

Media - 10 GB

Votiro CyberSec Ltd. Proprietary
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XML and JSON - 100 MB

AV scans are supported for file sizes up to 40 GB.
1.5 Votiro VA On-prem - Product Lifecycle Support

Votiro provides support on each release of VA On-prem for some time after issuing the
next release of the product. The exact end of support dates are listed in the table below.

Customers should take into account Votiro's policies regarding enhancements and bug
fixes:

Enhancements will be applied to the next release only.

Hot fixes will be provided for the supported versions. Other bug fixes will be applied
to the next release only.

Note:

Votiro highly recommends that users regularly upgrade to the latest version of Votiro VA
On-prem and not wait until the end of a release’s support cycle.

Votiro VA On-prem Product Lifecycle Support

Extended Support

Version Release Date End of Support
PP (Extra Fee)
v9.6.3 20 Feb 2022 29 Feb 2024 31 Dec 2024
1 202 10.
V9.7 02 Jan 2023 31Jan 2025/v10.0 31 Jan 2026
Release

31 May 2026/ v10.1

31 May 2027
Release ay

v9.9 12 May 2024

ETA - end of Q2

v10.0 2025

Votiro CyberSec Ltd. Proprietary Page 20



V O T I R D 2 Using the Management Dashboard

2 Using the Management Dashboard

The Management Dashboard enables you to perform the following procedures:

Monitoring Positive Selection Activity

Events Dashboard

Threat Analytics Dashboard

Filter by Channels

Cloud Connectors and Integrations

Configuring Settings

Generating Reports

Password Protected Portal

Note
Votiro Management Dashboard is supported using the Chrome browser only.

2.1 Logging in to the Management Dashboard: VA on-
premises
There are two ways the customer can sign in:

Sign in with Active Directory credentials - relevant for a customer that uses Active
Directory to authenticate users

Sign in with SSO (using corporate credentials) - relevant for a customer that has
integrated Votiro through SAML

2.1.1 Sign in with Active Directory credentials

For customers who use Active Directory to authenticate users, the user must enter the
Active Directory credentials:

User Name

Password

Votiro CyberSec Ltd. Proprietary Page 21
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VOTIRG

Sign In To Your Account

Enter User Name

Password

Sign In With SSO
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V 0 T I R U 2 Using the Management Dashboard

2.1.2 Sign in with SSO (using corporate credentials)

1. The customer can enter his corporate credentials to sign in to the Votiro
Management console using SSO. Click on Sign In With SSO.

VOTIRG

Sign In To Your Account

I:'mer Email Address

2. The following screen is displayed. Enter the Email address and click on Sign In.

Votiro CyberSec Ltd. Proprietary Page 23



V O T I R D 2 Using the Management Dashboard

VOTIRG

Sign In To Your Account
With SAML SSO

3. The customer is redirected to the corporate Identity Provider for authentication.
After authentication is successful, the Management console is displayed.

Note

The Management Dashboard locks down for 10 minutes following three failed login
attempts by a single username.

2.2 Monitor Dashboard

The Monitor dashboard allows monitoring and analyzing of traffic throughput as files are
processed for known elements. Any unknown elements within a file are identified and do

Votiro CyberSec Ltd. Proprietary Page 24
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not transfer to the newly constructed template received by the user.

A file is processed for positive selection according to policies for the particular file type.
Threats, determined by unknown elements, are detected regardless of policies, whether
the file is blocked or not.

There can be more than one recent activity message for a single file if it contains more
than one threat. For example, the file can contain a suspicious URL and a suspicious macro.

From the navigation pane on the left, click the Monitor icon in the navigation pane on the
left:

G

oo
&

The Monitor dashboard is displayed:

O 22 crames P

(®) tast300ays
5042025 - 157052025

Monitor

L~y Incoming Traffic [ON = (ONN ®
= Data Source L

) Volume Consumed

24 .. 136 <reees 7 soces | [E—r—— o e

0 e

Suspicious Objects Detected Hide Empty Dates

) Livestatus )

Noitems yet

The page contains the following panes, outlined in red and numbered as in the above
screenshot:

1 Time interval - filters the display by the selected time period. See Filter by Time
Period.

2 Channels - filters the display by the selected channels. See Filter by Channels.

3 Incoming Traffic - displays the number of Emails and files received during the
selected time period and for the selected channels. See Incoming Traffic.

4 Processed Files - displays the number of sanitized, blocked and password
protected files received during the selected time period and for the selected
channels. See Processed Files.

5 Volume Consumed - displays the volume of the files processed and the volume
remaining (in appropriate units: Bytes, KB, MB, GB, TB)

Votiro CyberSec Ltd. Proprietary Page 25
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2.2.1

2.3

2.3.1

2 Using the Management Dashboard

6 Suspicious Objects Detected - displays a histogram chart of suspicious objects
detected during the selected time period. See Suspicious Objects Detected.

7 Live Status - displays the most recent file traffic events. See Live Status.

8 Incoming Files - displays the incoming file traffic by file type during the selected
time period and for the selected channels. See Incoming Files.

File count for an archive file or email with attachments

We count the actual number of files that were sanitized regardless of whether multiple
files were compressed to an archive file or multiple files were attached to the email file .

For example:
An archive file has 5 children - it will be counted as 6 files instead of 1 file.
An EML has 5 attachments - it will be counted as 6 files instead of 1 file.
Other file types are not affected by these changes. For example:
A PDF file with 5 embedded images/files/etc. will be counted as 1 file.

A Word file with embedded images/files/etc will be counted as 1 file.
Monitoring Positive Selection Activity

The Monitoring Positive Selection Activity page allows monitoring and analyzing of traffic
throughput as files are processed for known elements. Any unknown elements within a file
are identified and do not transfer to the newly constructed template received by the user.

Afile is processed for positive selection according to policies for the particular file type.
Threats, determined by unknown elements, are detected regardless of policies, whether
the file is blocked or not.

There can be more than one recent activity message for a single file if it contains more
than one threat. For example, the file can contain a suspicious URL and a suspicious macro.

From the navigation pane on the left, click Monitor. See the description of the Monitor
dashboard at Monitor Dashboard.

Incoming Traffic

The Incoming Traffic pane displays the number of Emails and Files received during the
selected time interval and selected channels.

. Incoming Traffic @ S
>
=3~  Data Source

0 caie 24 ...
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V O T I R D 2 Using the Management Dashboard

The Incoming Traffic pane (3) displays the number of Emails and the number of Files
received during the selected time interval and selected channels. This includes
attachments to emails. For more details, see File count for an archive file or email with
attachments.

Extracting more data by drilling down

The displayed data can be modified by filtering and more data can be displayed by drilling
down in the chart.

To view a breakdown of emails and file types, click on either pane. A new pane opens on
the right-side of the page:

Votiro CyberSec Ltd. Proprietary Page 27



V 0 T I R CJ 2 Using the Management Dashboard

X
Incoming Traffic
From Jan 20th, 2024 to Jan 20th, 2025.
23 Emails 91 Files
BMP
excel (2007-2010) [N
PDF
Unsupported Media File -
WAV
Word (2007-2010)
zrrie [
0.4 L 10 20 40 1.
File count
Il Awverage Rate = Average Size
O Per hour 682'25KB
Per file

Extracting more data by drilling down

The displayed data can be modified by filtering and more data can be displayed by drilling
down in the chart. For more details, see Operational workflow.
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2.3.2 Password Protected Files

The Password Protected Files pane (5) displays the number of password protected files
processed during the selected time interval and selected channels.

<> Password Protected Files @

11 PPFs

Extracting more data by drilling down

To display details of the password protected files, click on the pane. The Events page

opens:

Events 21000, 2024192210, 20261923 ot -ran xS -t tere-5010 - ([
=)
E==)
=3
E=)
=3
o=

2.3.3 Processed Files

The Processed Files pane displays the number of Sanitized, Blocked and Password
Protected Files processed during the selected time interval and selected channels.

_ @,

. .
(®)  Processed Files

136 Sanitized 7 Blocked 1 Passward Protected

Extracting more data by drilling down

The displayed data can be modified by filtering and more data can be displayed by drilling
down in the chart.

To view a breakdown of emails and file types, click on either pane. A new pane opens on
the right-side of the page:
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Processed Files

From Jan 21st, 2024 to Jan 21st, 2025.

1-35K Sanitized 71 Blocked

11 o5

100 1000 100...
File count

EML File

HTML

Internal Office XML
JPEG

Mac AppleDouble enc...
PDF

PNG

Unkniown

Unknown Text

Word (2007-2010)

—
—
=]

Suspicious Objects Detected

0 Suspicious Fake File
@ Suspicious Unknown File
@ Suspicious Script File

2 5 Average
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2.3.4

2.3.5

2 Using the Management Dashboard

Extracting more data by drilling down

The displayed data can be modified by filtering and more data can be displayed by drilling
down in the chart. For more details, see Operational workflow.

Incoming Files

The Incoming Files pane displays histograms of the file types and emails received during
the selected time interval and for the selected channels.

& Incoming Files

100
10

‘ I | | I
S h npnm

Sep 24 Oct'24. Nov '24 Dec 24 Jan 25

Word (2007-2010) ® roF ® word Unsupported Media File @ Unknown TIF
® PNG Animated GIF ® M2 XML Unknown Text ® HTML
® css Mac AppleDouble encoded @ EML File wav ® Excel (2007-2010)

Filtering the Incoming Files

You may view the number of files processed for each file type in a selected time interval by
moving the cursor over the desired histogram. For example, in the screenshot below, the
cursor is moved over the green histogram to display Word (2007-2010): 2 files processed
during September 2024.

% Incoming Files

100
10 Word (2007-2010): 2

-

1

01
Sep '24

Waord (2007-2010)
® PNG
® css

You may also remove file types from the display by clicking on the file types below the
histogram. The selected file types are removed from the histogram display for the entire
selected time interval. In the below example, Word (2007-2010) and PDF files were
removed from the display and this is indicated by the file type names having a strike-
through line.
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Sep '24

. tonaron
® PNG
@ css

2.3.6 Live Status

I neem
Oct 24
® FBF ® word

Animated GIF ® MPa
Mae AppleDouble encoded @ EML File

Nov ‘24
Unsupported Media File
XML

WAV
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Dec 24 Jan'25
@ Unknown TIF
Unknown Text ® HTML

® Excel (2007-2010)

The Live Status pane displays the most recent file traffic events during the selected time
period and for the selected channels. Any suspicious files detected along with the date and
time detected and the reason the file was flagged as suspicious are displayed.

v Live Status

Suspicious Script File

Suspicious Script File

Suspicious Script File

Suspicious Script File

Suspicious Script File

Suspicious Script File

Suspicious Fake File

Script file detected in the artifact.

Script file detected in the artifact.

Script file detected in the artifact

Script file detected in the artifact

Script file detected in the artifact

Script file detected in the artifact

Suspicious fake file [extension does not match file structure]
detected in file: _logioptionsplus_installer.app

Dec 11, 2024 10:59 PM

Dec 9, 2024 9112 AM

Dec 8, 2024 11:40 PM

Nov 8, 2024 3:39 PM

Nov &, 2024 3:31 PM

Oct 8, 2024 1:23 PM

Oct 8, 2024 1:23 PM

To view more information on a flagged file, click on the row of the file in the Live Status
pane. A new pane view opens on the right-hand side of the Monitor dashboard page
displaying more details about the file. See File Details for more information.

2.3.7

Suspicious Objects Detected

The Suspicious Objects Detected pane displays a histogram chart of the suspicious objects
detected in the processed files for the time period selected. The files are displayed
according to their object or file types, such as Suspicious Fake File, Attribute Removed, etc.

Suspicious objects detected

Votiro CyberSec Ltd. Proprietary

Suspicious ScriptFile ® All Others ® Suspicious Fake File

Suspicious Unknawn File

Suspicious URL detected ®Assribute Remaved
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Extracting more data by drilling down

The displayed data can be modified by filtering and more data can be displayed by drilling
down in the chart. For more details, see Operational workflow.

2.3.8 Test File

To test a file, from the Management Dashboard navigate to Settings > Policies and click
Test File. Your file manager opens for you to navigate to the file you want to test, and
select it for testing. When testing has completed successfully a link is returned to the page.
Click Details to see information about the file used for testing, including the sanitization
log.

The file used for testing is stored and displayed as a regular file in Votiro. For further
information, see File Details on page 41.

2.4 Events Dashboard

The Events dashboard provides you with a deeper view of files that have been processed
for positive selection and are currently stored on the server. By default the full list of
incidents (up to 10,000 events) that have occurred during the last seven days is displayed.
You can narrow the list of incidents by using filters (see Event Filters).

From the Events dashboard, you can release files that have been blocked.

Use this page to explore incidents (blocked and processed files).

From the navigation pane on the left, click the Events icon in the navigation pane on the
left:

The Events dashboard is displayed:
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Events

Filters (Gear

0 seleccal

fc- Credit card record.docx

sample dataxisx
@ STl
acr,adapt dataformat for

@ _PKanalixxism 17Flles sanitzed 1 Brvacy Risks 0 Suspicious Opjects 0Fle Blocked 3185 Seniization Time ‘

o testiie

@ ¢ Credk cand record oo Do s prvacy s [T — oricsecies S sevesion e gt |

The page contains the following panes, outlined in red and numbered as in the above
screenshot:

1 Event filters - filters the display by additional event filters. See Event Filters.

2 Events List - displays the files received during the selected time period and for the
selected channels and event filters. See Events List.

The Events page also contains the following controls:
Bulk Release - after selecting blocked emails from the Event Files table,

clicking on this button releases all the blocked emails. See Releasing Multiple Emails
for more details.

w Export Events - clicking on this button downloads a csv file summarizing all the

Event files displayed on the page. The following data is included in the csv file:
Date & Time
Filename
Subject - for emails
From - for emails
Recipients - for emails
Blocked Files
Suspicious Objects
File Type
Sanitization Time (Seconds)
Iltem ID
Hash
Connector Type

Connector Name
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Link

View Details (in the Event Files pane) - clicking on this button displays details for the
file in the corresponding row. See File Details.

2.5 Event Filters

The Event Filters pane allows you to filter the Events files displayed.
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Filters Clear &
Search
Free Search

Specific User

Filter by mail address

Time Range

Last 30 Days -
Channels

3 Selected —
File type

Select -
Suspicious Object Type

Select -
Status

Show All —

Password Protected

Show All -

Post Process

Show All -

Privacy Data Type

Select —

Compliance Regulation Rule

Select -

Private Data Labels

No label filter applied b

The filters available include:

Search - free text search. The Event Files displayed will contain all file names that
contain the search text. For example:
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Select Al tems (0)

S

cy Data Type

Privacy Data Entity Label

2 Using the Management Dashboard

B - I -

Specific User - filter a specific user by specifying the user's full email address. The
Event Files displayed will contain all file names associated with the specific user's

email address. For example:

o Pl PiNdocx
Sap 10, 2024 1048 a0

& Pl PN decx

Events (3 26 Aup 2024015 25 S, 2024105

Note: This filter is available for the following connectors only:

API
OneDrive
Teams
SharePoint
0365 Email

Browser Plugin

Time Range - select the time range from the dropdown list.

Channels - select the file connector from the dropdown list.

Votiro CyberSec Ltd. Proprietary
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File Type - select a file type from the dropdown list. The default is all possible file
types are displayed. The options are described in File Types.

Suspicious Object Type - select a suspicious object type to search for from the
dropdown list. The options are described in Suspicious Object Types.

Status - filters the display by the selected status. The options are:
Show All - display all events. This is the default.
Sanitized - display events with sanitized files only.

Blocked - display events that have at least one blocked file, including inner
files.

Root Blocked - display events where the root file is blocked.

Password-Protected Files - select whether to display password-protected files. The
options are:

Show All - display all files. This is the default.
Yes - display password-protected files only
No - do not display password-protected files
Post Process - select
Show All
Released Events - blocked emails that were released

Retroscan Findings - incidents found using the Retrospective findings filter on
the Events page

Privacy Data Type - select a privacy data type to search for from the dropdown list.
The options are described in Supported Data Types.

Compliance Regulation Rule - select a compliance regulation rule to search for from
the dropdown list. The options are described in Supported Regulations.

Private Data Labels - select a privacy entity label to search for from the dropdown
list. Private Data Labels are described in Supported Data Labels.

Events List

The Events List pane displays a list of files processed for the selected time period and the
selected channels and selected filters.
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@

@

@

@

@

Select All ltems (0)

1c - Credit card record.docx
Jan g, 2025 112 PM

ic - Credit card record.docx
/2N 8, 2025 1107 PM

e - Credit card record.docx
jan 8, 2025 451 P

1c - Credit card record.docx
jan 8, 2025 218 PM

1c - Credit card record.docx
jan8, 2025211 P

Malicious_code_embedded_in_i

Jan's, 2025 9:46 P

1c - Credit card record.docx

Jan1, 2025 9:42 P

. - Credit card record.docx

imag

12 Fles

12 Files Sanitized

12 Files Sanitized

12 Flles Sanitizea

12 Flles Sanilizeg

12 Flles Sanitized

8 Privacy Risk:
6 Privacy Risk:
6 Privacy Risk:

6 Privacy Risks

6 Privacy Risks

0 Ppeivacy Risks

0 Fies Block
0 Suspicious Objects  OFiles Blocked
0 Suspicious Objects  OFiles Blocked
O Suspicious Obects O Files Blocked
0 suspicious Objects  0Files Blocked

0 Suspicious Objects O Files Bloeked
0 Suspicious Oblects O Files Blocked

16 sec Sar

 Sanilzation Time

01 se¢ San

rlization Time

tization Time

®

The table of files displayed includes:

File name

Number of Files Sanitized - if the file is an archive or email, this number includes

attached files

Number of Privacy Risks

Number of Suspicious Objects

Number of Files Blocked

Sanitization Time - in seconds

Date Pic

Select Al tems (0)

er

10 Feb, 202416157 - 10 Feb, 2025 16:57

Specific User - filter a specific user. The Event Files displayed will contain all files

owned by the specific user. For example:
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goaang g

Note: This filter is available for the following connectors only:

This filter is available only for

Status - filters the display by the selected status. The options are:

Status
Show All

Sanitized

Blocked

Root Blocked

Show All

The default is Show All.

File Type - select a file type from the dropdown list. The default is all possible file
types are displayed. The options are described in File Types.

Suspicious Object Type - select a suspicious object type from the dropdown list. The
options are described in Suspicious Object Types.
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Compliance Regulation Rule - select a compliance regulation rule from the
dropdown list. The options are GDPR, CPRA, HIPAA, QuebecPrivacyAct AND APPI.
These are described in Supported Regulations.

Privacy Data Type - select a privacy data type from the dropdown list. The options
are PII, PHI and PCI. These are described in Supported Data Types.

Privacy Data Entity Label - select a privacy entity label from the dropdown list.
Private Data Labels are described in Supported Data Labels.

Password-Protected Files - select whether to display password-protected files. The
options are:

Yes - display password-protected files only
No - do not display password-protected files
Show All - display all files. This is the default.
Post Process - select from:
Released Events - blocked emails that were released

Retroscan Findings - incidents found using the Retrospective findings filter on
the Events page

Show All
Sort Order - select the sort order . The options are:

Ascending - display the earliest files first.

Descending - display the latest files first. This is the default.
Sort By - select the sort argument. The options are:

Date
2.6.1 File Details

To view more details of a file listed in the Event Files table, click on the View Details
button on the right side of the row containing the file. See File Details for more
information.

2.7 File Details

The File Details pane opens on the right side of the screen:
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X
1c - Credit card record.docx : -
Jan 8, 2025 11112 PM
Using policy "Auto Classify"

View Full Details
12 Sanitized 0 Blocked
6 Privacy Risks 0 Suspicious Objects

Related Files by File Type
Internal Office XML

Word (2007-2010)

0 2 4 6 8 10 12

Privacy Risks

Personal Information Detected

Personal information was detected of the following types: Ssn,
BankAccount, CreditCard, CreditCardExpiration, Cvv,
RoutingNumber

Suspicious Object List

d)
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The file details are displayed according to the selection from the Related Files Hierarchy.

2.7.1 Download and Release file options

To select more options for the file, click on the 3 dots icon at the top right of this pane and
select the desired download or release option:

Download Original
Download Sanitized
Release Criginal
Download Unmasked File

Release Unmasked File

2.7.2 View Full Details

To view more file details, click on the View Full Details button:

1 - Credit card record.docx i || @ Processedries @ | @ :"““"‘"ED & Pprivacy Risks @ || & suwicions @ sanitization Time ®
Jan 8,2025 11:12PM w
Using policy "Auto Classify" 12 saniizea 0 soces [ 1.7 seconas
Related Files Hierarchy ® ||privacyrisks @ || rie vetais @ || patarrocessin
+ c - Credit card record.docx File name
[Content_Types].xml 1c - Credit card record.docx B File Uploaded
rels -
document.xmi D
Settings.xmi Dbe92c7d-badb-deab-90d9-6e30e288bb31 o
styles.xml
webSettings.xml
fontTable.xml Word (2007-2010) [
core.xmi .
ile size .
appoxml ‘Suspicious Object List ®
document.xml.rels . 131Kie L
themet.xmi
Original tem hash v
d) - °
No suspicious object was found L]
User .
kina@3klI2f.onmicrosof ft.com [ v
Related Files by File Type @ || emaitntormation )
ject v F
Internal Office XML - L] - L]
Recipient v
Word (2007-2010) s
0 1 2 3 s 7 s B o om e

The following panes are displayed:
1 Processed Files (Sanitized) - number of files sanitized
2 Processed Files (Blocked) - number of files blocked
3 Privacy Risks - number of privacy risks detected
4 Suspicious Objects - number of suspicious objects detected
5 Sanitization Time - sanitization time in seconds

6 Related Files Hierarchy - displays attached files
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7 Privacy Risks - displays Personal Information Detected (if any) and Personal
Information Masked (if any)

8 Suspicious Object List - displays list of suspicious objects detected (if any)
9 File Details - displays the following file attributes:

File name

ID

File type

File size

Original item hash

Connector name

Users

Path

Groups

Client

Server

From

To
10 Data Processing - displays the high-level sanitization logs trail, including:

File Uploaded

True File Type

AntiVirus Scan

CDR process logs

DDR process logs

Sanitization Done
11 Related Files by File Type - displays a histogram of related files by file type
12 Email Information - including:

Subject

From

Recipients
2.7.3 Channels

The statistics displayed on the Monitor and Events pages relate to the file and email
connectors that are currently selected. If you have more than one Votiro Connector
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installed, you can filter the file list by Connector using the Channels list.

Channels Selected: 6

File Connector - One Drive File Connector - Share Point Fi m

File Connector - One Drive

File Connector - Share Point
File Connector - Browser plugin
File Connector - MS Teams
Mone - Self-sanitization

Email Connector - Office365 Channel

1. To display statistics for specific connectors, click on the Channels box.
2. Check the box next to each desired connector.

None - Self-sanitization refers to user-uploaded files through the Test File
button on the Policies dashboard.

3. To select all available connectors, click on Select All.

Statistics update to show information for the selected Channels.
2.7.4 Date Picker

The statistics displayed on the Monitor and Events pages relate to the period that is
currently selected. You can select a predefined period by clicking on the Date Picker box.
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Date Picker
1 Dec, 2024 19:46 - 18 Dec, 2024 19:46 B
Last hour « < December 2024 January 2025 > »
Today
Last 24 hours 1 1 2 3 4 5
Last 7 days 2 3 4 5 6 7 8 6 7 8 9 10 11 12
Month to Date 9 10 pukl 12 13 14 15 13 14 15 16 17 18 19
Last 30 days 16 17 malg 19 20 21 22 20 21 22 23 24 25 26
23 24 25 26 27 28 29 27 28 29 30 31
Last 90 days ?
30 31
Last year
Start: | 19 46 00 End: 19 46 00

Range: 11 Dec, 2024 19:46 - 18 Dec, 2024 19:46 | Cancel | m

Votiro On-prem provides the following predefined settings:

Period of Processing Activity Meaning

The information is for the period starting 60 minutes earlier

Last hour . .
until the current time.

The information is for the period starting at 00:00 (midnight) of

Toda
y the current day until the current time.

The information is for the period starting from the current time,
Last 24 hours . . .

24 hours earlier, until the current time.

The information is for the period starting from the current time,
Last 7 days . . . - .

7 days earlier, until the current time. This is the default option.

The information is for the period starting at 00:00 (midnight) of
Month to Date ) P . 9 . ( ght)

the first day of the month until the current time.

The information is for the period starting from the current date
Last 30 days . . . .

and time, one month earlier, until the current time.

The information is for the period starting from the current date
Last 90 days . . . .

and time, three months earlier, until the current time.

The information is for the period starting from the current date
Last year

and time, one year earlier, until the current time.

Allows you to define the period to display information for by
Custom selecting from and to dates and times from the calendar
selection tool.
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Defining a Custom Period

1. Click on the Date Picker box..

2. In the left pane, navigate to the desired start month and year by clicking the left
arrow (<) to move to the previous month, or by clicking the left double arrow (<<) to
jump to the same month in the previous year. If necessary, use the right arrow (>)
or right double arrow (>>) to go forward in time.

3. After reaching the desired starting month in the left pane, click on the desired
starting day of the month. The box containing the selected day of the month is
highlighted in black.

4. In the Start boxes below the month, type the desired starting time. For example:

& £ December 2023

|

4 5 B 7 8 9 10
11 12 13 14 15 16 17
18 19 20 21 22 23 24

25 26 27T 28 2% 30 3

Start: | 08 0o 00

5. In the right pane, navigate to the desired end month and year by clicking the right
arrow (>) to move to the next month, or by clicking the right double arrow (>>) to
jump to the same month in the next year. If necessary, use the left arrow (<) or left
double arrow (<<) to go back in time.

6. After reaching the desired ending month in the right pane, click on the desired
ending day of the month. The box containing the selected day of the month is
highlighted in black.

7. In the End boxes below the month, type the desired ending time. For example:
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June 2024 > b

10 11 12 13 14 15 16

17 18 19 20 21 22 23

24 25 26 27 28 29

End: | 23 59 59

8. Click Apply. The custom period is displayed in Date Picker box.

Date Picker

01 Dec, 2023 08:00 - 30 Jun, 2024 2359

Statistics update to show information for the custom period.

Retro Scan

This feature highlights the value of Votiro On-prem's Zero-day protection against Anti-
Virus engine signature deficiencies.

Each file that enters your network is rescanned by Votiro On-premevery 3, 8 and 28 days
against Anti-Virus engines. The Retro Scan capability can display whether Votiro On-prem
detected the incoming file as a threat when the Anti-Virus engine did not.

For example, suppose an incoming file was marked by the Anti-Virus engine as "clean", but
Votiro On-prem marked it as "malicious". Now suppose that the Anti-Virus signatures were
later updated and when the file was rescanned the Anti-Virus engine marked it as
"malicious". This means that Votiro On-prem blocked the potential real-time (Zero-day)
attack when the Anti-Virus engine could not.

You can view all such incidents by selecting the Retrospective findings filter on the Events
page.

Releasing Files

You can release the original version of a file or a blocked email from the Incidents page.
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I CAUTION!

These procedures should be performed by a system administrator, and only in special
circumstances.

Releasing the Original Version of a Blocked File

If a file has been blocked, you can release it from the blob and send it to the OUT folder
configured in Votiro On-prem for File Transfer.

Note

To enable the release of blocked files, you must first configure Votiro On-prem for File
Transfer.

To release a blocked file from the Incidents page, click Release Original.

The original file is sent to the OUT folder.
Releasing the Original Version of a Blocked Email

If an email has been blocked, you can release it from the blob and send it to one or more
email recipients.

Note

To enable the release of blocked files, you must first configure the following system
settings:

SMTP Server location
SMTP Server port

SMTP Server username
SMTP Server passwords

For more information, see Configuring Settings on page 133.

If the released file is of type EML, the original sender's email address appears in the
email that contains the attachment.

If the released file is of another type, the email address of the user defined for the
SMTP Server username setting appears as sender in the email that contains the
attachment.
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To release a blocked email follow these steps:

1. On the Incidents page, tap an email file, then click icon to Release Original.

The following dialog is displayed:

Release original email

To

userl@orgg.local x

Bee

| Fanee! |

The dialog shows the same email addresses that were included in the original email,
as well as their original designations: To, Cc, or Bcc.

2. Accept the email addresses that are displayed or delete one or more, as required.
You cannot add email addresses.

3. To send the email, click Release. The email is sent.

Releasing Multiple Emails

o o o
|- - é
1. On the Incidents page, check the box at the beginning of each row of an email. An

email is identified as such when the Connector type is Email Connector.

2. Click Bulk Release to send the emails.

Note

Bulk Release supports the Votiro Email connector only (Office 365 is not supported).

2.8 File Types

In the Event Filters pane, select a file type to search for from the dropdown list. The
default is all possible file types are displayed. The options are:

Not Discovered Yet
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Unknown

Empty File

Directory

Unrecognized

Huge File

Word

Word (2007-2010)
WordXML

Excel

Excel (2007-2010)
ExcelXML

Power Point

Power Point (2007-2010)
PowerPointXML

Visio

Project

Obsolete Office Files
Excel with Macros

Word with Macros
Power Point with Macros
Excel on xml format
Power Point Template
Word Template

Excel Template

Macro File

Word Pre 2007 Template
Power Point Slide (2007-2010)
Power Point Slide with Macros (2007-2010)
Printer Settings

Binary Excel (2007-2010)
Visio (2007-2010)

Visio with Macros

Votiro CyberSec Ltd. Proprietary
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WordXML Macro Enabled
Model item data
Open Word
Open Spreadsheet
WEBP

Pcx File

ICO

JPEG

WMF

EMF

GIF

TIF

BMP

PNG

Portable Gray Map Image File
PPM File

WDP

Animated GIF
SVG

HEIF

MP2

MP3

M4A

WAV

WMA

AVI

MOV

MP4

MPEG

WMV

3GP

M4v

Votiro CyberSec Ltd. Proprietary
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MKV

FLV

Corrupted PNG
Unsupported Media File
Material Exchange Format File
CD Audio Track Shortcut File
Text

XML

Postscript File

Internal Office XML
ShiftlisText

Unknown Text

JSON

INI

Script

Embedded Macro Files
Certificate

EML File

DAT File

TNEF File

TNEF Calendar Files
MSG File

Encrypted EML File
Restricted Permission Message
ZIP File

RAR File

7Z File

GZip File

RARS File

CAB File

InstallShield CAB File

VMware Virtual Machine Disk

Votiro CyberSec Ltd. Proprietary
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Tar File
LZH File
XZ File
BZIP2 File
Executable
MST files
Binary File
JTD File

JTDC File

Encrypted Ichitaro File

DICOM File
Thumbnail File
Statistical Files
LabView

VCF

RTF Files

DXF File
Adobe Air

PDF

PST ANSI

PST

RPT

JAR

HTML

INF File

SQL File

MHT File
Calendar File
CSS

DWG File
PreR14Dwg File

DWS File

Votiro CyberSec Ltd. Proprietary
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DWT File

JWW File

p7s

DWF File

HTML Body

HTML Attachments

XFA

PSD File

V-nas BFO File

XDW File

SolidWorks File
Parasolid model File
Initial Graphics Specification File
ZSoft PCX bitmap File
CATIA Product Data File
eDrawings File

ACIS Solid Model File

Sfc File

P21 File

Shortcut File

RSP File

Solution User Option File
Pgp File

Tableau Workbook
Tableau Packaged Workbook
Tableau Hyper Data Base File
HWP File

Excel95 File

PreWord97 File

HWP 3.0 File
PowerPoint95 File

HWPX File

Votiro CyberSec Ltd. Proprietary
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HML File

Excel2 File

Excel3 File

Excel4 File

1QY File

SLK File
SettingContent-ms File
Unknown Ole Object
Docx Ole Object

Docm Ole Object

Dotx Ole Object

Xlsx Ole Object

Pptx Ole Object

Bmp Ole Object

Pdf Ole Object

Equation Ole Object

Slide Ole Object

SlideX Ole Object

SlideM Ole Object

Xls Ole Object

Pptm Ole Object

Jtd Ole Object

Doc Ole Object
JustFocuse Slide Ole Object
JustFocuse Presentation Ole Object
Hwp Ole Object

Xlsb Ole Object

Link Ole Object

DB Files

Mac AppleSingle encoded
Mac AppleDouble encoded

Mac OS X folder information

Votiro CyberSec Ltd. Proprietary
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2.9

MAC OS X crash log

Apple iWork

Suspicious Object Types

Suspicious Macro
Suspicious Office Excel 4.0 Macro

Suspicious File System Activity Macro

Suspicious Out of Document Interaction Macro

Malicious Macro

Suspicious Fake File
Suspicious Unknown File
Suspicious Executable File
Suspicious Script File
Suspicious Threat File Detected by Antivirus
Max Depth detected
Duplicate Key detected
Complex File detected
External Program Run Action
External Link Path

External Frame

External Attached Template
External Online Video
External Ole Link

External Image

Dynamic code execution
Suspicious URL detected
Xml Bomb detected

Zip Bomb detected
Suspicious File Structure
Svg Bomb detected

Suspicious Threat File

Votiro CyberSec Ltd. Proprietary
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In the Event Filters pane, select a suspicious object type to search for from the dropdown
list. The options are:
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DDE detected

Open Action Removed
Remote Access Removed
Xfa Script Removed
Open Action Removed
Script Tags Removed
External Image Removed
Element Removed
Attribute Removed

External Reference Removed

2.10 Threat Analytics Dashboard

The Threat Analytics dashboard displays data about suspicious files or objects.

From the navigation pane on the left, click the Threat Analytics icon:

Threat

analytics

ritaton comrgs [0
in events ® emai

< 26 . 0.6% wcnce
o oawsss ©
Oc= 0.0% -occ
box B e

Suspicious objects detected ® 0 - 0.0% susees
@ d [>]
Oc= 0.0% <ocee
B Microsoft Teams (>}
- le= 0.0% oo
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The page contains the following panes, outlined in red and numbered as in the above
screenshot:

u 1 Time interval - filters the display by the time period selected. See Filter by Time
Period.

| 2 Channels - filters the display by the channels selected. See Filter by Channels.

| 3 Targeted Users - displays the top users targeted with suspicious files. See Targeted
users.

u 4 Top suspicious files - displays pie charts of the top suspicious files. See Top
Suspicious Files.

| 5 Win events - displays the number of Win events detected during the retrospective
scan. See Retro Scan.

| 6 Suspicious objects detected - displays a histogram chart of suspicious objects
detected during the selected time period. See Suspicious Objects Detected.

| 7 Organization Coverage - displays a breakdown of sensitive files per channel. See .
2.10.1 Targeted users

The Targeted users pane displays a histogram of the top ten users targeted with suspicious
files. Each user is represented by a histogram. The length of the histogram corresponds to
the number of suspicious files, which is plotted on the horizontal axis.

Targeted users

]
I

userXIESaa
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Extracting more data by drilling down

The displayed data can be modified by filtering and more data can be displayed by drilling
down in the chart. For more details, see Operational workflow.

2.10.2 Top Suspicious Files

The two pie charts displayed in the Top Suspicious Files pane relate to the top ten
suspicious files containing sensitive data according to the following categories:

| By object type - files classified according to object type. These include, among
others:

External Program Run Action
Suspicious Executable File
Suspicious Fake File
Suspicious File Structure

Suspicious Unknown File

® & & o o o

External Attached Template

[ ] By file type - files classified according to file type, such as Executable, Word, PDF,
EML, etc.

Top suspicious files
By object type By file typa

® External Program Run Action @ Executable

® Suspicious Executable File ® Mac AppleDouble encoded
Suspicious Fake File Word (2007-2010)

@ Suspicious File Structure ® Word

® Suspicious Unknown File ® Unknown

@ External Attached Template ® 7ZFile

@ All Others @ All Others
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2.10.3

2.10.4

2.10.5

2 Using the Management Dashboard

Extracting more data by drilling down

The displayed data can be modified by filtering and more data can be displayed by drilling
down in the chart. For more details, see Operational workflow.

Suspicious Objects Detected

The Suspicious objects detected pane displays a histogram chart of the suspicious objects
detected in the processed files for the time period selected. The files are displayed
according to their object or file types, such as Suspicious Fake File, Attribute Removed, etc.

Suspicious objects detected

Extracting more data by drilling down

The displayed data can be modified by filtering and more data can be displayed by drilling
down in the chart. For more details, see Operational workflow.

Retro Scan

This feature highlights the value of Votiro On-prem's Zero-day protection against Anti-
Virus engine signature deficiencies.

Each file that enters your network is rescanned by Votiro On-premevery 3, 8 and 28 days
against Anti-Virus engines. The Retro Scan capability can display whether Votiro On-prem
detected the incoming file as a threat when the Anti-Virus engine did not.

For example, suppose an incoming file was marked by the Anti-Virus engine as "clean", but
Votiro On-prem marked it as "malicious". Now suppose that the Anti-Virus signatures were
later updated and when the file was rescanned the Anti-Virus engine marked it as
"malicious". This means that Votiro On-prem blocked the potential real-time (Zero-day)
attack when the Anti-Virus engine could not.

You can view all such incidents by selecting the Retrospective findings filter on the Events
page.

Filter by Channels

The statistics displayed in the DDR dashboards relate to the file and email connectors that
are currently selected. If you have more than one connected integration installed, you can
filter the file list by Connector using the Channels list.

Votiro CyberSec Ltd. Proprietary Page 61


../../../../../Content/Votiro Cloud User Guide/Management Dashboard/06 Filters/Operational workflow - On-prem.htm
../../../../../Content/Votiro Cloud User Guide/Management Dashboard/06 Filters/Operational workflow - On-prem.htm

VOTIRG

2.10.6

£+ Channels - Clear al
Q, | Search
Crieck a
Uncheck a
|_\_| Mone
I_Ll Email Connector
[ Dfficelas Channe
El File Conmector
[/ One Drive
I_Ll Share Point
El Brow ser plugin
[/ M3 Teams

2 Using the Management Dashboard

To display statistics for specific connectors, click on Channels.

Check the box next to each desired connector.

To include test files, check the None box.

To select all available connectors, click on Check all. To clear all the selections, click

on Uncheck all.

Statistics update to show information for the selected Channels.

Filter by Private Data Labels

The statistics displayed on the Privacy and Compliance dashboard can be filtered by the
Private Data Labels that are currently selected for each private data type selected.

S, Private Data Labels ~

Clear al

Pl
a

I
ACCOUNT

MUMBER

Oooooaoano

AGE

DATE

DATE INTERMAL

DOB

DRIVER LICENSE
DURATION -
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PCl
[] BANKACCOUNT
[] CREDIT CARD

[] CREDIT CARD
EXPIRATION

] cw
[] ROUTING NUMBER

PHI

BLOOD TYPE
CONDITION

DOSE

DRUG

INJURY

MEDICAL PROCESS

I I O A

[ sTATISTICS
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Select one or more of the Private Data Labels by checking the appropriate boxes in each
Private Data Type category :

PII - Personally Identifiable Information (PIl) is any information connected to a
specific individual that can be used to uncover that individual's identity. See Table 1
Pl data labels for a detailed list of PIl data labels.

PHI - Protected Health Information (PHI) is any information in the medical record or
designated record set that can be used to identify an individual. See Table 2 PHI
data labels for a detailed list of PHI data labels.

PCI - Payment Card Industry (PCI) data apply to all entities involved in payment card
processing — including merchants, processors, acquirers, issuers, and service
providers. See Table 3 PCl data labels for a detailed list of PCI data labels.

Use Filter privacy labels to filter the list for a specific data label. For example, to see if SSN
was checked:

:_(_'E\-} Private Data Labels -

Pl PCl PHI

To uncheck all selected private data labels for all private data types, click on Unselect all.

Filtering by Private Data Labels in the Privacy and Compliance
Dashboard

To filter the view by specific data labels, use Filter privacy labels to search for and filter
the list for the desired data label. For example, to view only sensitive files containing SSN:

1. In Private Data Labels, click on Unselect all.
2. Enter the desired private data label in the Filter privacy labels box. For example,
ssn.

3. Check the box next to the desired privacy data label. For example, SSN.

F:\-} Private Data Labels -

—
WA
il
=

o

Pll PCI PHI

SSN
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4. Click on the desired pane in the Privacy and Compliance dashboard, for example,
the Top Sensitive Users pane. The statistics are updated to reflect the new selected
data.

Top Sensitive Users

king@3kIZf onmicrosoft.com: 13 (source: user)

5. The Private Data Labels are updated to show the filtered selection:

:_f;l',\_) Private Data Labels -~

5zn

2.10.7 Filter by Private Data Types

The statistics displayed on the Privacy and Compliance dashboard can be filtered by the
Private Data Types that are currently selected.

@ Private Data Types ~

[v] P
[ PHI
[+ Pa

Select one or more of the private data types by checking the appropriate boxes:

Pl - Personally Identifiable Information (Pll) is any information connected to a
specific individual that can be used to uncover that individual's identity. Examples
include account number, driver license, email address, name, username, password,
phone number, SSN, etc.

PHI - Protected Health Information (PHI) is any information in the medical record or
designated record set that can be used to identify an individual. Examples include
blood type, condition, dose, etc.
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PCI - Payment Card Industry (PCl) data apply to all entities involved in payment card
processing — including merchants, processors, acquirers, issuers, and service
providers. Examples include bank account, credit card, routing number, etc.

2.10.8 Filter by Time Period

The statistics displayed in the DDR dashboards relate to the time period that is currently

selected.

You can select a predefined time period by clicking its button or define a custom period.

[—_? | Last 30 Days -
e Last Hour
Today
Last 24 Hours
Last 7 Days

Current Month

Current Year
Last Year

Custom

Votiro On-prem provides the following predefined settings:

Period of Processing Activity

Last Hour

Today

Last 24 Hours

Last 7 Days

Current Month

Last 30 Days

Votiro CyberSec Ltd. Proprietary

Meaning

The information is for the period starting 60 minutes earlier
until the current time. The time interval displayed is by minute.

The information is for the period starting from 00:00 of the
current day until the current time. The time interval displayed
is by hour.

The information is for the period starting from the beginning of
the current time, 24 hours earlier, until the current time. The
time interval displayed is by hour.

The information is for the period starting from the beginning of
the current time, seven days earlier, until the current time. The
time interval displayed is by day.

The information is for the period starting from 00:00 of the first
day of the current month until the current time. The time
interval displayed is by day.

The information is for the period starting from the current time,
one month earlier, until the current time. The time interval
displayed is by day.
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Period of Processing Activity Meaning

The information is for the period starting from 00:00 of the first
Current year day of the current year until the current time. The time interval
displayed is by month.

The information is for the period starting from the beginning of
Last Year the current time, one year earlier, until the current time. The
time interval displayed is by month.

Allows you to define the period to display information for by
selecting from and to dates from a calendar selection tool.

Custom

Defining a Custom Period

1. Click Custom to display the period selector.

{ Dec s | 2024 ¢ >
December 2024 January 2025

1 2 3 4 5 6 7 1T 2 3 4

g8 9 W NM121314 5 6 7 8 9 10N

15 16 17 18 19 20 21 12 13 14 15 16 17 18
2225 % 278 192021 22232435
29 30 31 26 27 28 29 30 31

Apply cancel

2. Navigate to the desired start month and year by clicking the blue right (>) and left
(<) arrows, or by selecting a month and year using the up (*) and down (V) arrows.

3. To select a start date, tap a date on the calendar, the number turns blue.

4, To select an end date, tap a date on the calendar, the number turns blue.
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The selected period is highlighted.

< Nowv $ | 2024 = >
November 2024 December 2024

Su Mo Tu We Th A S5a 5 Mo Tu We Th F 53

3 4 5 6

3 4 5 6

10 11 12 13

17 18 19 20

10 11 12 13

17 18 19 20

24 25 26 2T

5. Click Apply.

The custom period is displayed in the top left corner of the window:

@ | Custom ~
01/11/2024 - 24/12/2024

Statistics update to show information for the custom period.
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2.11 Cloud Connectors and Integrations

Use the Cloud Connectors and Integrations menu to configure settings in Votiro's
Management Dashboard for specified connectors and application integrations.

AWS 53

Menlo Security

Box

File Cloud

2.11.1 AWS S3 - VA On-premises

To get to the AWS S3 page, from the navigation pane on the left, click Cloud > AWS S3.

AWS S3

Policy Name * Name

Select a policy to work with the connector Default Policy v
Queue URL URL

Type in the AWS queue UR https:/fsqs.us-west-1.amazonaws.com/5:
Access key Key

Type in your AWS access key

Secret key Key

Type in your AWS secret key

The AWS S3 page contains the following fields:
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Element Field
1 Policy Name

2 Queue URL
3 Access Key

4 Secret Key

Note

2 Using the Management Dashboard

Description

Specify a policy for the AWS S3 connector to work with.
Select the Default Policy if you have not created an
alternative policy to use.

Specify the AWS queue URL. See below for details.
Specify the AWS access key of the IAM user.
Specify the AWS secret key of the TAM user.

Fields marked with a * red asterisk are mandatory, to be completed.

As you make changes the Items Changed count increases. When finished making changes
at the bottom of the page select to either Save Changes or Reset to the original settings.

Prerequisites

AWS SQS (Simple Queue Service) Queue (see Creating an AWS SQS Queue for

details)

Amazon S3 (Simple Storage Service) bucket

AWS IAM (ldentity and Access Management) user that has access to SQS and S3

Creating an AWS SQS Queue

You must create an AWS SQS (Simple Queue Service) Queue for S3 bucket integration.

1. Login to your AWS account.

2. Navigate to Simple Queue Service.

3. Click on Create queue.

1 ©
Encryption v Content-based deduplication v
4, Under Type, select Standard.
5. Enter a Name for the queue.
6. Modify the values according to the example below:
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Create queue

Details

O Stndard wts FIFD 1ot

Hame

Myvotend

Configuration

7. For the Access policy, choose Advanced.

8. You may use the below template and replace <AWS_ACCOUNT_NUM>, <QUEUE_
NAME> and <BUCKET_NAME> with their actual values:

{

"Version": "2012-10-17",
"Id": "example-ID",

"Statement": [

{
"Sid": "example-statement-ID",
"Effect": "Allow",
"Principal": {

"Service": "s3.amazonaws.com"
}y
"Action": [

"SQS:SendMessage"

I

"Resource": "arn:aws:sgs:us-east-1:<AWS_ACCOUNT_
NUM>: <QUEUE NAME>",

"Condition": {
"ArnLike": {
"aws:SourceArn": "arn:aws:s3:*:*:<BUCKET NAME>"

}y
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"StringEquals": {

"aws:SourceAccount": "<AWS_ACCOUNT_ NUM>"

}

9. Under Tags, you may create an optional tag for the queue by setting Key to "Name'
and Value to the queue name, for example:

= Redrive allow policy - Optional

*

10.  Other options should remain at their default values.

11.  Click on Create queue.
Assigning the Queue to an Existing S3 Bucket

1. Navigate to the desired bucket.

2. Select the Properties tab.

3. Scroll down to Event notifications.

4. Click on Create event notifications.

5. Set the Event name to the desired name.

6. Under Event types, select All object create events. For example:
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Create event notification i

The notification configuration identifies the events you want Amazon 53 to publish and the destinations where you want
Amazon S3 to send the notifications. Learn more [4

General configuration

Event name

MyVotiroQ-object-created

Event name can contain up to 255 characters.

Prefix - optional
Limit the notifications to objects with key starting with specified characters.

Suffix - optional

Limit the notifications to objects with key ending with specified characters.

Event types

Specify at least one type of event for which you want to receive notifications. Learn more [

All object create events
s3:0bjectCreated:*

All object removal events
s3:0bjectRemoved:*

Permanently deleted
s3:0bjectRemoved:Delete

Delete marker created

s3:0bjectRemoved:DeleteMarkerCreated

Restore object events

Restore initiated
53:0bjectRestore:Post

Restore completed
s3:0bjectRestore:Completed

7. Under Destination, select SQS queue.
8. Under Specify SQS queue, select Choose from your SQS queues.

9. Select the SQS queue from the list of available queues. For example:

Votiro CyberSec Ltd. Proprietary Page 72



V 0 T I R D 2 Using the Management Dashboard

Destination

@ Before Amazon 53 can publish messages to a destination, you must grant the Amazon $3 principal the
necessary permissions to call the relevant API to publish messages to an SNS topic, an SQS queue, or a
Lambda function. Learn more [

Destination
Choose a destination to publish the event. Learn more Z

Lambda function
Run a Lambda function script based on 53 events.

SNS topic

Send notifications to email, SMS, or an HTTP endpoint.
O 5Q5 queue

Send notifications to an SQS queue to be read by a server.

Specify SQS queue
© Choose from your SQS queues
Enter SQS queue ARN

SQS queue
L] v

10. To save the SQS queue configuration, click on Save changes.

Example of an IAM User JSON Policy with Limited Access to the
Bucket

To use the example below, replace <AWS_ACCOUNT_NUM>, <QUEUE_NAME> and
<BUCKET_NAME> with their actual values.

{
"Version": "2012-10-17",

"Statement": [

"Effect": "Allow",

"Action": [
"s3:PutObject",
"s3:GetObject",
"s3:GetObjectTagging",
"s3:DeleteObject",
"s3:PutObjectTagging"

1y

"Resource": "arn:aws:s3:::<BUCKEI_NAME>/*"
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by

"Effect": "Allow",

"Action": "sgs:*",

"Resource": "arn:aws:sgs:us—east-1:<AWS_ACCOUNT NUM>:<QUEUE _
NAME>"

}

AWS S3 Flowchart

The following diagram illustrates the procedure:

The Flow of an Uploaded File

Aws

1
83Busket | i A S3Bucket )}
- 1 e .
b I P T
~. AddTag
>
- Key: Votiro
! A Value: Sanitized
A C
1
1

Original file is
laced with th

tagged 100% safe

Votiro Cloud * processed file

* also works with
virtual appliances

Positive Selaction Engine®
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2.11.2

Prerequisites

Menlo Security

2 Using the Management Dashboard

You need to import the Menlo Root CA certificate. See Menlo Security Production SSL
Inspection Root CA Certificate.

Configuration of Menlo Security in Votiro

1. Navigate to the Votiro Management Console and select System setup > System

Configuration.

2. Copy the Votiro Tenant Id to the clipboard.

AWSs3

Menlo Security

System Configuration

Votiro Tenant Id

Monitor Mode

Login Session Timeout

Enable session timeout to define a limit on user inactivity. If

ecify the duration in minutes before timeout

Company Name

on next login

Type in your company name

File History
Select the nu

mber of days to keep files in storage

Password Protected File History

Select the numbs

storage

er of days o keep password protected files in

Menlo Security Isolation Platform

Monitor Mode

Policy Name

Select a policy to work with the connector

Channel Name.

Items Changed

Enable

Defauit Policy

4, The Menlo Security page contains the following fields:
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Element Field Description

Monitor Mode is intended for potential customers to
experience our product before purchase and has the
following features:

Experience and test our product with the
customer's files.

Get insights and analytics using our
0 Monitor Mode Management dashboards.

Does not interrupt the organization's workflow.

Monitor mode sanitizes files to gather file analytics, but
the user always gets the "original" file.

By default, Monitor Mode is disabled for editing. To
enable this feature, please contact Votiro support.

Specify a policy for the Menlo Security connector to
1 Policy Name work with. Select the Default Policy policy if you have
not created an alternative policy to use.

Specify the Votiro Tenant ID, which can be obtained

2 Token Id
oxen from the System Configuration page.
Specify the name of your channel. The channel name
3 Channel Name appears in the Incidents page as the name of a

connector.

5. Paste the Votiro Tenant Id from the clipboard to the Token Id field.
6. Type a name for the Channel Name, for example "Menlo Connector".

7. Select a Policy Name to work with the connector.

Menlo Security Isolation Platform

Channel Name.

8. Click on Save Changes.
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Configuration of the Cloud Connector to Menlo Security

1. Login to the Menlo Administrator page at Admin Portal. The Menlo Dashboard
appears:

Dashboard EHONNONN G ]

Web > Overview

Web Overview Last 30 days -
® 2 ©
A 40 7 3 95.9%
WEBSITES OVERALL THREATS AVERTED USERS PROTECTED TRAFFIC ISOLATED
& cass
B Reporiing
Top Threat Types Top Threat Origins
Breakdown of threat types encountered by Menlo Securiy number of threar
o .
135615927 s
Risky File 4
Uncategorized site s
VIEW DETALS + VIEW DETALLS »

Traffic Volume
Numb est

. A A

2. Click on the Apps button and select Policy.

Dashboard

Web > Overview

Web Overview

[::] =2
40 7 3 95.9%
WEBSITES OVERALL THREATS AVERTED USERS PROTECTED ‘TRAFFIC ISOLATED
Q cass
D Reporting
Top Threat Types H Top Threat Origins
fown of threat types en y y ber of thre
bazsarsbuse.ch s
135615927 s
.
orized site s
VIEW DETAILS + VIEW DETALLS »

Traffic Volume

3. On the sidebar menu, click on Content Inspection.
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(MENLO | Policy

SECURITY

& web

GLOBAL POLICY
Threats
Categories
Copy & Paste
Watermarks
Documents / Archives
File Downloads
File Uploads
EXCEPTIONS
S5L Decryption Exemptions

Policy Exceptions
SETTINGS

Policy Settings

DLP

Applications

Content Iﬁpectinn

CASB

SaaS Headers

4. From the submenu that opens, click on Plugins and Integrations.
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[& Content Inspection v

Plugins a nw tegrations

Analysis Exceptions

5. The Plugins and Integrations page is displayed. In the Integrations section, go to

the Menlo File REST API row and click on the Edit icon at the end of the row.

® wen
B o
O Applications >

(& Comentinspection v

P

Q cs

@ SaaS Headers

6. The Menlo File REST API Integration page is displayed.

Applications >

[& Content Inspection v

Plugins.

a cass

@ SaaS Headers

Policy

Content Inspection » Plugins and Integrations

Plugins and Integrations
Settings for handiing virus and malware analysis for downloaded documents or fils.

Plugins
SERVICE NAME DESCRIPTION TRANSFER AND APPLICATION TYPE
File Hash Check Mult-Engine Hash Check for Virus Any Transfer, Only Browsers
FullFile Scan AntiVirus Scan Any Transfer, Only Browsers
SandBox Inspection Cloud-Based SandBox Inspection Downloads, Only Browsers
Integrations
SERVICE NAME DESCRIPTION TRANSFER AND APPLICATION TYPE
WildFire Analysis WildFire Malware Analysis Downloads, Only Browsers
Menlo Fle REST API Server Itegration Any Transer, Only Browsers

€ Edit Menlo File REST API
Menlo File REST API Integration
Menlo File REST API Server Integration Settings
Menlo File REST API Menlo File REST API Server Integration

Base URL and Certificate
This i used for validation of the TLS connection to the extemal service. This i the certificate of the CA which signed the certificate.

htips/

File Details and Transfer Type

3 900
1 400000
Transfer Type

Any Downloads Uploads @

Hash Check || Metadata Check (8 Allow File Replacement [ ] Skip Validaion of Certificate

Actions

7. On the Edit Menlo File REST API Integration page:

a. In the Base URL field enter the value supplied by Votiro: Base URL.

b. In the Authorization Header field, paste the Votiro Tenant Id you saved.

c. Verify that the field Allow File Replacement is checked.
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Policy ® 0 6
@ ow po—
Menlo File REST API Menlo File REST AP| Server Integration
O Applications
Base URL and Certificate

B Contentinspection v
This is used for validation of the TLS connection to the external service. This is the certificate of the CA which signed the certificate.

Plugins and Integrations.

A
CA Cerificate
& cass > )
L
@ SsaSHeaders > il Details and Transfer Type’
ORI RKIOKANHNKKHNKNX
3 900
1 400000

Transfer Type

Any  Downloads  Uploads  ©

Allow File Replacement| [ | Skip Validation of Certificate

Hash Check || Metadata Check|

Actions.

Continue Inspection ~ Send max size bytes  Block

d. Toggle the Menlo File REST API switch to ON and then click on the Save
button.

EB&  Policy
Content Inspection » Plugins and Integrations: Reset Changes.
® wed
@ ow
Plugins and Integrations
T ekcatozs Setings for handling virus and malware analysis for files
[ Content inspection v Plugins.
Plugins and Integr
ot ond ineorons) 'SERVICE NAME DESCRIPTION TRANSFER AND APPLICATION TYPE
An
File Hash Check MultiEngine Hash Check for Virus Any Transfer, Only Browsers
casa
a FullFile Scan AntVirus Scan Any Transfer, Only Browsers
@ SeaS Headars > ‘SandBox Inspection Cloud Based SandBox Inspection Downloads, Only Browsers
Integrations
SERVICE NAME DESCRIPTION TRANSFER AND APPLICATION TYPE
WildFire Analysis WildFire Malware Analysis Downloads, Only Browsers: »
Menlo File REST API Menlo File REST APIServer Integration  Any Transer, Only Browsers E

e. The message Rules Saved. Ready for publishing should be displayed. Click on
the Publish button to publish the settings to the tenant.
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2.11.3

Policy

Content inspection » Plugins and Integrations.

® we

B ow

Plugins and Integrations

DO Applications Settings for handling virus and malware analysis for downloaded documents or fles.

[ Content inspection v Plugins

Pl .
- Lo SERVICE NAME DESCRIPTION TRANSFER AND APPLICATION TYPE

File Hash Check MultiEngine Hash Check for Virus Any Transfer, Only Browsers

oA
a o Full File Sean AntiVirus Scen Any Transfer, Only Browsers

@ 52a5 Headérs ‘SandBox Inspection Cloud-Based SandBox Inspection Downloads, Only Browsers

Integrations

SERVICE NAME DESCRIPTION TRANSFER AND APPLICATION TYPE

WildFire Analysis WildFire Malware Analysis Downloads, Only Browsers.

Menlo File REST AP Menlo File REST API Server Integration Any Transfer, Only Browsers

N

. Ready for publishing

Box

Votiro On-prem and Box

Using the Management Dashboard

The diagram below describes the architecture of the Votiro On-prem - Box interface;

Votiro and Box Architecture

User uploads file to Box »

@
=

___ Box Sync uploads files to Box __

Box App "tells" Box to
send uploaded and 7 ™
synced files to Votiro
>

<

=3

\ /

Votiro-Box-App

Safe & sanitized file sent back to Box

File copy is sent to Votiro for sanitization

Al 2

. m‘l‘

Votiro Saa$
Platform

Configuration of an App in Box to Integrate with Votiro On-
prem

1.

2.

Login to your Box.com account with Admin privileges.

In the Box menu, select Dev Console (if you can’t find the button go to Dev

Console).
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mx Q, Search Files and Folders ==~

All Files All Files > test-folderl

Recents

Synced Folder Word Document Excel Spreadsheet
7 Notes

Relay

S Apps

Trash

My Collections

8 Favorites

Get started by adding your first file

Create new documents directly within Box or upload an existing file

Upload -
al £ aConsole
<I> Dev Console
3. On the My Apps page, Click on theCreate New App button:
mx DEVELOPER M
y Apps
My Apps Select an app or create a new app
APl Docs
SDKs
Support
(+)

Create New App

4. Select Custom App:
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a.
b.

C.

box e

</> APIDocs

</> SDKs

Support

Votiro CyberSec Ltd. Proprietary

My Apps » Create New App

Select an app type to get started

©

Custom App

Best for the majority of apps an
integrations. Supports both server-
server and end-user apps

+ Select desired authentication
method (user or enterprise)

+ Select application's access (i.e
scopes)

« Create webhooks

+/ Publish apps to the App Center
or as integrations

+/ Reguest access to all files and
users in an enterprise

View Documentation

On the Custom App pane:

Click on the Create App button:

2 Using the Management Dashboard

Limited Access App

Best for Box View apps or
previewing Box content in another
application

+f Server side authentication with
an app token

+ Request access to all files and
users in an enterprise

% Cannot access all APl endpoints

% Cannot edit scopes, default
scopes are set

% Cannot store data in the
Enterprise

% Cannot publish apps to App
Center

View Documentation

Type in an App Name (for example, Votiro-Box-Integration).

Box Custom Skill

Best for apps that want to use an
external service to enrich content
with metadata

+ Send content to a third party
service based on updates to a
file in Box

+ Utilize a Box provided secure
token for easy, secure data
trasfer between services

+ Create metadata on a Box file
based on information from a
third party service

% Cannot publish Skill to App
Center

View Documentation

Select the Authentication Method as Server Authentication (with JWT).
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Custom App

Select an authentication method and enter a name for your
app. You can change the name later in General Settings.
Authentication Method
Server Authentication (with JWT)
= Best for building integrations or apps with external
collaborators - Learn More
ithenticates using a JSON Web Token. Requires a
public/private key-pair for added security.
User Authentication (OAuth 2.0)

= Best for building mobile or web apps - Learn More

= Users must authenticate with their Box login

Server Authentication (Client Credentials Grant)

= Best for scripting and back office integrations - Learn More

= The app authenticates using Client ID and Client Secret

App Name

Votiro-Box-Integration

By clicking 'Create App’, you agree to the terms of the Box Developer
Agreement and the Box Privacy Policy.

6. Select the Configuration tab, then select “App + Enterprise Access”:

Votiro-Box-Integration

General Settings Configuration « Authorization App Diagnostics

Manage authentication methods and app permissions

7. Select App + Enterprise Access.
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App Access Level

The app access level determines which
users and content your app may
access. All Server-Server apps
authenticate using an access token for
the Service Account (Automation User)
by default. Read more about the
Service Account.

App Acce

+/ Service Account and App Users
only. Learn more.

+ Access to content created by
your app.

¥ Cannot manage Enterprise

2 Using the Management Dashboard

App + Enterprise Access

o Allusers

+/ Manage Enterprise settings,
content, and users.

% Limited access to External
Unmanaged Users.

8.

10.

Votiro CyberSec Ltd. Proprietary

settings, content, or users.

Make sure you check all the checkboxes under Application Scopes and Advanced
Features:

Apalication Scopes

Content Actians

ur apy can

rn mare abaut all

[#] Manage signature recuests
g th B

1 endpaits. Learn mare sbout Box Sign AP
Administrative Actions

(7] Manage users

[+ Manage grauns

(= Managa retantion policies

Ir use the Governance add-on.

|+ Manage entearise properties
1 use with the event stream, enterprise’s attrites, and device pins, Anp + Enterprise Access is required 1o use Lhis scope
Developer Actions
[7] Manage webheaks
[#] Enable integrations

@ Manage Bow Relay

wteract with Box Ralay endpaints. Learm mare anout Bo kalay AP

Advanced Features Make API calls using the as-user header

Choose which advanced features your

application requires. Warning: These Generate user access tokens

should only be used for server-side Allows your application to generate another users’ access tokens using a grant instead of requiring their credentials

development. Learn more.

Click the Save Changes button:

Votiro-Box-Integration -]

E——

Scroll down to Add and Manage Public Keys and click on Generate a Public/Private

Keypair (this step might require 2FA approval) and save the prompted JSON file to
your machine:

General Settings Configuration Webhooks Authorization App Disgrastics

Manage authentication methods and apg permissions
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Add and Manage Public Keys ) ) i K
Add a Public Key Generate a Public/Private Keypair

Generate an RSA keypair to sign and
authenticate the JWT request made by
your app or upload your own public
key. Learn to generate your own RSA
keypair.

Note: Box does not store your private
key, so make sure you save the
downloaded file if you are using our
generate button.

A configuration file with all of your app settings has been
downloaded. Since Box does not store your private key, this file
contains the only copy of your private key, so store it securely.

Note: If the JSON file is not downloaded, click again on Generate a Public/Private
Keypair.

11. Add the Votiro On-premURL to the Allowed Origins section:

CORS Domains Allowed Origins (optional)

Comma-separated list of Origins https://{ClusterFQDN}.paralus.votiro.com
allowed to make a CORS request to

the API. For security purposes, enter

only those used by your application.

Avoid the use of trailing slashes in the

URL unless specifically required. Learn

more.

12.  Click the Save Changes button again:

Votiro-Box-Integration

General Settings Configuration Webhooks Authorization App Diagnostics

Manage authentication methods and app permissions »

13.  Select the Authorization tab and:
a. Click on Review and Submit.

b. Type an App Description
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c. Click on the Submit button:

Review App Authorization Submission

App Info

App Name
Votiro-Box-Integration

Client ID
ngfnSaiewumyberkd 1n3b5zdyxknkImh

App Description

Enter a brief descript

14.  Your Box admin should receive a confirmation email, similar to the screenshot
below.
Click on Review App Details:
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box

New authorization request for the custom app,
Votiro-Box-Integration

One of your developers, _ submitted a custom app for avthorization. If you

need more information about custom app approvals, check out this documentation.

Below you will find some of the configuration information for the app:

Developer Name

App Name
Votiro-Box-Integration

Authentication Type
OAuth 2.0 with TSON Web Tokens

Client ID

Description

You can review the app details and take action from the admin console.

Review App Details

15.  You’ll get redirected to Box.com again.

a. Go to the Custom Apps Manager and select your new app.
b. Click Authorize and review your app settings.
C. Click on the Authorize button:
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Authorize App

Review the information in order to authorize thi

Name
Votiro-Box-Integration

16.  After the Box app is configured, you must configure it in the Votiro On-prem
Management Dashboard, as described in the following section.

Configuration of the Box App in the Votiro On-prem
Management Dashboard

To get to the Box page, from the navigation pane on the left, click Cloud Connectors > Box.

Box App Settings

Offica365 Mail

Channel Name
Box Connector

Monitor All Users

The Box page contains the following fields:

Field Description

Specify a policy for the Box connector to work with. Select the

Policy Name
Y Default Policy if you have not created an alternative policy to use.
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Field Description

To integrate with the Box account, add the Public/Private
Keypair by pasting the content of the JSON file you saved to your
machine when creating the Custom App in Box to integrate with
Votiro On-prem. The keypair is located in the JSON file.

Box App Settings

Specify the name of your channel. The channel name appears in the
Channel Name Incidents page as the name of a connector. In the example above,
the channel name is "Box Connector".

Check this box to enable all users under the Box enterprise account

Monitor All Users
to perform sanitization when uploading files to Box. *

* displayed only if Monitor All Users is not checked.

The left column will contain all users under the Box enterprise
account. To authorize specific users to be able to sanitize files, select

*Monitored Users the users from the left column and click Add. To deny sanitization
authorization to specific users, select the users from the right column
and click Remove. To add/remove all/no users, click the All/None
buttons in the respective column.

* displayed only if Monitor All Users is not checked.

The left column will contain all groups under the Box enterprise
account. To authorize specific groups to be able to sanitize files,
select the groups from the left column and click Add. To deny

*Monitored Groups sanitization authorization to specific groups, select the groups from
the right column and click Remove.

If a group is enabled/disabled for sanitization, all the group users are
enabled/disabled even if the group users were not enabled/disabled
in the Monitored Users field.

* If you uncheck Monitor All Users, the following options are displayed:
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Monitor All Users E.]f...:r i users
Choose whether to monitor all Box.com users or

selected users/groups

e =T =~ R

Move users to monitor to the right column

itamar
Itamar2

Yaara Pinhas

Move groups to monitor to the right column

supergroup

Box App Behavior when Uploading Files

Each file that an authorized user uploads to Box will be automatically send to sanitization.
When the user uploads a file, Box will display a message:

“"Meeting summary 6-12.docx" was uploaded
@ successfully. X

After the sanitization is successfully completed, the original file will be replaced with the
sanitized file, and Box will display a message indicating that a new version of the file was
uploaded:

A new version of "Meeting summary 6-12.docx" was
@ just uploaded. Would you like to refresh the page? X

Box App Behavior when Versioning Files

| If an uploaded file was successfully sanitized, the sanitized file will be marked by V3:
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All Files > Ron

¢ Version History

Today

Current Version -

v3 Uploaded by Ron Fonkatss

Today at 3:23 PM « 3.7 MB

| If the uploaded file was blocked, a blocked PDF file appears marked by V2:
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a VA-ClosingFWports-v1.0.sh_Blocked.pdf [VZ]

The contents of the blocked file PDF will be similar to:

VOTIRG

We have blocked this file in adherence
to your organization policies. Please
contact your IT department for further
information.

The binary file was blocked in adherence to the
organization’s policy.

ltem Hash:

302c968ab3el1227d54df4e72f39088d7483d25eeb3037f0bl6bc39cef272
afad

Item 1D:
815e0e48-5a0b-42ad-acaa-f48bB0812faf

Correlation ID:
815e0e48-5a0b-42ad-acaa-f48b80812faf

Box App Behavior for Password Protected Files

If the user uploaded a password protected file, the original file will be replaced with a
password protected blocked PDF marked by V2:

[ a Password1.xlsx_Blocked.pdf [vZ) Today by Ron Fonkats 382KE e P Share ]

To release a password protected file that was blocked:
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1. Click on I have a password in the blocked PDF. The password protected portal is
displayed:

VOTIRG

The attached file is password

protected.

You can safely receive the

attached file.

Enter the file's password:

[JRemove the file password after sanitization

Release to Box.com

Click here if more than one password is required

2. Enter the file's correct password and click on Release to Box.com. Votiro displays
the message:
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VOTIRG

The sanitized file has been

released to your Box account.

The sanitized file appears in Box marked by V3:
a Password1.xisx (V3

Limitations

Sanitization of uploaded files by external users is not supported.
2.11.4 Fortinet Sandbox

Prerequisites

To activate Fortinet Sandbox integration, please contact Votiro support.

Configuring the Fortinet Sandbox Integration

To get to the Fortinet Sandbox page, from the navigation pane on the left, click Cloud >
Fortinet Sandbox.
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Sandbox

Fortinet sandbox Server Address IP / Hostname

Type in your organization Fortinet sandbox server
address

Fortinet sandbox Username Usemame

Type in your Fortinet sandbox username

Fortinet Sandbox Password Password

Type in your Fortinet sandbox password

Test Connection Test

perform a connection test to the sandbox server

1. Enter the following fields:
Fortinet sandbox Server Address
Fortinet sandbox Username
Fortinet Sandbox Password

2. Press the Test button. This action tests the connection to the Fortinet Sandbox
Server. Success/Failure is indicated by V/X.

Note: Saving the configuration will be possible only after the test connection succeeds.

Setting a Sandbox Policy

After the sandbox settings are successfully configured, a new Sandbox option will appear
in the Policies Dashboard.
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P Choose how to handie data files or nidentified file types
sandbox policy

option
Case Default action Exceptions Default Action
— 0 (@ ) o)

Password Protected 0

Block Reason )
Large File . 0
Complex File . 0
Special Case )

File type Default action Exceptions
POF o
Image 0
Binary 0
Archive 0
RTF o
Email 0
Microsoft Office 0
Text 0
Other Files . o

Select the Default Action by pressing the Sandbox button. The file will be either blocked or
sent, depending on the outcome of the Sandbox analysis.

The Block Reason will display the Sandbox Result.

Note: The Sandbox is not as quick as Votiro Disarmer. Files sent to the Sandbox may
impact performance.

File Information from the Sandbox

The results of the Sandbox processing of the file will appear in the Sanitization log.

2428b71-4117-4d63-a44-be917e 46128
Files. File actons v File Info Santtization Log| details actions performed by Fortinet
v With embedded GVE exe .pdt Data Processing

5855786/691589059916742b3cTc4793

, 1b3sab
689 20

2 Files Sanitized 2 Threats Detected
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2.11.5 Office365 Mail

Office365 High-level Workflow

1__Anemailis 2A
received in
0365 mailbox

2B

< | 3 Email is sent to Votiro
For sanitization
\Y

4 Safe & sanitized email
Is returned

. ‘ Votiro platform
Votiro Office365 Connector

Office365 Integration Limitations

Office365 native integration does not update emails using an Apple native client (as
opposed to Outlook for Mac/iPhone).

If you are using Microsoft Defender for Office 365 (previously known as Office 365
ATP), enabling Dynamic Delivery can cause missing attachments when using Votiro
On-prem. Consider selecting the Monitor or Blockoption instead:
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Microsoft Defender

Settings

Safe Attachments unknown malware response

Settings ct the action for unknow ware in attachments.

R * Monitor and Blo

* Dynamic Deliver,

ttach files after scanning is

Quarantine policy

to release quarantined

When sending an email to a Microsoft 365 group, it can either be delivered
individually to each group member's mailbox or appear as a single copy in the
group’s dedicated folder, depending on the group’s configuration. This behavior is
determined by the setting explained in the Microsoft documentation: Send copies
of group conversations to group members' inboxes.
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If the setting "Send copies of group conversations and events to group members" is
enabled, and the group members are protected, Votiro will receive individual
notifications for each recipient, and the email will be sanitized accordingly. For
example, sending a message to Apps@votiro.com results in multiple items
appearing under Prod US.

However, if this setting is disabled, Votiro does not—and cannot—receive
notifications for those messages. In such cases, the message is stored in the group's
folder as part of a Microsoft resource type called a conversation, which our
application permissions do not allow us to monitor or subscribe to for notifications.
In this case, sending a mail with a suspicious link to a protected group results in the
file not being blocked.

Office365 Integration Procedure

Enter the Management Console as the Admin of Office365 Mail and navigate to
Cloud Connectors and Integrations > Office365 Mail.

Click on the Setup Office 365 Integration button. The Votiro product will be
redirected to Microsoft user authentication.

Select your Admin account.
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BT Microsoft

Select an account

King Ron
E king.ron@votiro.com

entersd

—I— Use another account

4, After authenticating with the selected Admin user, approve Votiro product
permissions and click on Approve to complete the successful integration.
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B Microsoft

king@3kll2f.onmicrosoft.com

Permissions requested

Review for your organization

Votiro_Mail_US

Votiro, Inc. €

This app would like to:

s/ Sign in and read user profile

. Read directory data

++ Read mail in all mailboxes

' FAead and write mail in all mailboxes

W you accepl, this app will gpet access to the specified resources
for all users in your organization. Mo one alse will be prompted to
feview thisse permissions.

Accegting these permissions means that you aliow this app 1o

usa your data as spacifiad in their lerms of service and privacy

statement. The publisher has not provided links to their terms

for you to review. You can change these permissions at
hittps/myapps. microsoftcom. Show detads

Doas this app look suspicious? Raport it here

s IR

5. After successful integration, the Votiro Management console will display the
Office365 Mail configuration screen.
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Office365 Configuration

Office365 Mail

Azure Tenant id

Policy Name

Channel Name

Monitored Groups

The Office365 Mail page contains the following fields:

Element Field Description

The organization's Azure Tenant ID

1 Azure Tenant Id
Note: This field cannot be changed.

Specify a policy for the Office 365 connector to work
2 Policy Name with. Select the Default Policy policy if you have not
created an alternative policy to use.

Specify the name of your channel. The channel nhame
3 Channel Name appears on the Incidents page as the name of a
connector.

The left column will contain all users under the Azure
tenant account. To authorize specific users to be able to
sanitize files, select the users from the left column and

4 Monitored Users click Add. To deny sanitization authorization to specific
users, select the users from the right column and click
Remove. To add/remove all/no users, click the All/None
buttons in the respective column.
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Element Field Description

The left column will contain all groups under the Azure
tenant account. To authorize specific groups to be able
to sanitize files, select the groups from the left column
and click Add. To deny sanitization authorization to

5 Monitored Groups specific groups, select the groups from the right column
and click Remove. If a group is enabled/disabled for
sanitization, all the group users are enabled/disabled
even if the group users were not enabled/disabled in
the Monitored Users field.

1. Select a Policy Name from the given options. You can define a new policy from the
Policies tab. In the example above, the Policy Name is "Office 365 Policy".

2. Type a Channel Name. In the example above, the Channel Name is "Office 365".

3. When finished making changes, click on Save Changes.
Office 365 Behavior when using the Votiro Office 365 App

1. When sending email with attachments to the protected users/groups, the
attachments will be sent to the Votiro On-prem engine for sanitization.

2. While the attachments are undergoing sanitization by Votiro On-prem, the
recipient’s mailbox attachment will be replaced with an InProcess_<filename>
attachment:

<votiro.demo@votiro.com>

To: Votiro demo

nProcess_Votiro demo.7z
Reply * Forward
3. After the attached file completes the sanitization processing, the results are
displayed.
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a. If the attachment was sanitized successfully, the sanitized file will be
displayed in the mailbox:

<votiro.demo@votiro.com>

To: Votiro demo Tue 11 022 11:50 AM

. Votiro demo.7z

20 KR

€\ Reply 2 Forward

b. If the attachment was blocked, a blocked PDF file will replace the original
attachment.

« &« -~

o
oy

<votiro.demo@votiro.com:> S
To: Votiro demo Tue 11/22/2022 11:59 AM

Eli icon.jpg_blocked.pdf

37 KB

<~ Reply ~~ Forward

4. The sanitization rate is a maximum of 6900 emails per hour.
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Note: There may be a delay before the client receives the sanitized attachment or
blocked PDF, due to:

1 1In Office 365, Votiro receives the email at the same time the client gets it.
2 Then we sanitize the file and replace the file (on the Microsoft Office 365 server).

3 Once the client "refreshes" the attachment, they will get the sanitized version or
blocked file.

4 Till then, it all depends on the client, and we have no control over it (some clients will
go to the server on every click, some will do it periodically).

5 For some clients, it will take a while until the client will re-query the server and get
the blocked PDF.

Office 365 App Behavior for Password Protected Files

1. If the user receives an email with an attached password protected file, the attached
file will be replaced with a password protected blocked PDF.

<yvotiro.demo@votiro.com=>

Demo PPF.pdf blocked.pdf
[ ] ]
“ Reply * Forward
2. To release a password protected file that was blocked:
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a. In the blocked PDF, click on I have a password. The password protected
portal is displayed:

VOTIRG

The attached file is password

protected.
You can safely receive the

attached file.

Enter the file's password:

[ Remove the file password after sanitization

Release to Office365

Click here if more than one password is required

b. Enter the file's password and click on Release to Office 365. Votiro displays
the message:
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VOTIRG

The sanitized file has been

released to your Office365

account.

C. The attachment will be replaced with the sanitized password protected file:

Votiro CyberSec Ltd. Proprietary Page 108



V 0 T I R D 2 Using the Management Dashboard

<votiro.demo@votiro.com>

lo: Votiro demo

Demo PPF.pdf

LY

Reply + Forward

2.11.6 FileCloud
FileCloud Configuration for Integration with Votiro On-prem

To authenticate FileCloud with Votiro On-prem, generate an API key.

1. Login to your FileCloud account with Admin privileges.

@@ FiLEcowd

LogIn

# FILECLOUD

BY CODELATHE

ce
‘ L e

Forgot Password Login

2. In the Admin portal navigation pane, click Settings, and then select Third Party
Integrations.

3. Select the McAfee MVISION CASB tab.
4, Select the checkbox Enable FileCloud CASB integration.

5. Change the value of the FileCloud CASB API Key to any alphanumeric string.

6. Click Save.
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Server Storage Authentication Admin Database Email Endpoint Backup License
Third Party Integrations ServerLink Misc Reset
Anti-Virus Salesforce SIEM reCAPTCHA McAfee MVISION CASB ICAP DLP

McAfee MVISION CASB Integration Settings

Enable FileCloud CASB

integration . _ -
Select to enable McAfee MVISION CASB

FileCloud CASB API Key RonDemoApikey

Set FileCloud CASB API Key

Add the value of the FileCloud CASB API Key to McAfee MVISION CASB.

Creation of a FileCloud Output Folder

Our new product solution offers our customers a new way to handle sanitized files.

Customers can choose an output folder, and every file that a FileCloud user uploads to any
desired folder will be sanitized and placed inside the designated FileCloud output folder.

1.

2.

Open the FileCloud console.
Select All Files > My Files.
Create a new folder. This will serve as the output folder.

Copy the new folder path (it will be needed for configuration of FileCloud in the
Votiro Management Dashboard).

i@ FiLEcLous a . £ () RonFonkats -

“ -
A w >

Votiro Sanitized Files © A Fies and Foicers [IREI

uuuuu Macified sas =

Apr 032023 9:41AM +

Ratantion Pasicy &

Notifications =

¥ Notice &

B Deleted Files

Share the new output folder with any users that need to have access to it.
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Configuration of FileCloud in the Votiro On-prem Management

Dashboard

To get to the File Cloud page, from the navigation pane on the left, click Cloud Connectors
and Integrations > File Cloud.

File Cloud

FileCloud API key

Policy Name

Selact a policy to work with the connector King

FileCloud Server Address Server address.

Type in your FileCloud server address httpsy/#votirofc filecloudiabs.com

Typein your FileCloud APl key

Name

Jran/Vatire Sanitized Files

The File Cloud page contains the following fields:

Field
FileCloud Server Address
FileCloud API key

Policy Name

Channel Name

Output Folder

Save the configuration.

Votiro CyberSec Ltd. Proprietary

Description

Specify the FileCloud server address. The address must include
https://

Specify the FileCloud API key.

Specify a policy for the FileCloud connector to work with. Select the
Default Policy if you have not created an alternative policy to use.

Specify the name of your channel. The channel name appears in the
Incidents page as the name of a connector. In the example above,
the channel name is "File Cloud".

Specify an output folder to contain sanitized files (the folder that was
configured in FileCloud, as described in Creation of a FileCloud
Output Folder). If left empty, files will default back to their original
location.
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FileCloud Behavior when Uploading Files

1. Any file upload will be directed to the Votiro On-prem sanitization process.

2. After the file is uploaded, it is deleted and then replaced by a sanitized version of
the file upon completion of the sanitization process. Note that this process may take
some time, and therefore the sanitized file will not be displayed immediately.

@@ FiLecLou - & O fomFomkas -
- -
L
— P C=
My Files J ¢ i
.....
(=]

. 5

Maifications. =

If the file was blocked, the original file is replaced by a blocked PDF that contains an
explanation of the reason for blocking the file.

VOTIRG

We have blocked this file in adherence
to your organization policies. Please
contact your IT department for further
information.

The image file was blocked in adherence to the
organization’s policy.
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Votiro Management Console — Monitoring

For monitoring and further investigation, browse the Votiro Management console to get
more information on the uploaded files.

Monitor o mm 0 - VOTIREJ

) imcaming Teute IR T — i O R— &) venme

0. 5 it 688.19KB
B Processed fika i ) Proceased fil i 18 Fie Connaceer - Fie Cous 4 UiveStatn

18 4. " 023s. Rl ——

e
— —
.
Incidents R p— - |
S [ =]
e =
SRR ==
, T — vt
an
L 808- BO207156 Lipg m
18.. 0o 1
r—— P—— [IR— PS—
Extmrmal image « . P
fa—
-
[TR—— Fike dtnds gl.n PR
——
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Limitations
The supported file size is up to 2 GB.

2.11.7 Chrome Browser Extension

Description

This document describes the installation, deployment and usage of Votiro's Chrome
browser extension.

The browser extension can be:

downloaded and installed by centralized deployment using GPO (Group Policy
Object). See Centralized Deployment using GPO (Group Policy Object).

downloaded and installed manually. See Manual Deployment.

downloaded and installed in the Microsoft Edge browser.
downloaded and installed in the Cyberark Secure Browser.

The user's manual is described at Chrome Extension User's Manual.

Limitations

The Chrome browser extension does not work with Microsoft 365 webmail.

The Chrome browser extension does not support the Chrome browser option to
enable the user to indicate where to save each file before downloading. You must
disable this option as follows:

a. In the Chrome browser, navigate to Settings > Downloads.

b. Disable Ask where to save each file before downloading.
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®

Settings O, search settings
You and Google
Downloads

Autofill and passwords
Location
Privacy and security C\Users\ \Downloads

Performance - A5k where to save each file before downloading

@

Appearance
Show downloads when they're done [ o)

Search engine

g ° ® 0 & @ )

Default browser

c

On startup

-]

Languages

[

Downloads

=4

Aceessibility

}v

System

©

Reset settings

¥

Extensions (£}

About Chrome

)

Base64 images are directly embedded inside the webpage as text (inside HTML or
CSS). Because they are part of the page itself, they don’t require a separate URL and
therefore cannot be "whitelisted" regularly.

Base64 images are just images converted into text using a special encoding

called Base64. Instead of storing an image file (like .jpg or .png), Base64 turns the
image into a long string of letters, numbers, and symbols.

Regular images are stored as files on a server, and the browser loads them using a
URL (https://example.com/image.png).

Centralized Deployment using GPO (Group Policy Object)

To deploy Votiro's Chrome extension using GPO, the domain admin must implement the
following steps:

1.

2.

3.

Update the domain controller group policy with Google's Chrome extension.
Central installation of the extension from the Google web store to users.

Central configuration of the extension’s parameters in the Registry (for Windows,
this depends on the operating system).

While this document refers to GPO steps explicitly, the deployment can be done by most
standard tools for domain policy management (such as Microsoft Configuration Manager
(formerly System Center Configuration Manager (SCCM)), PolicyPak and others).
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Centralized Deployment Procedure

1. Add Chrome Policy Templates

a. On your domain controller, navigate to the URL Chrome browser for
Windows, and download the correct 32 or 64 bit zip bundle. Extract the
Google Chrome bundle to your desired location, for example: C:\temp

b. Navigate to the directory in which you extracted the Google Chrome Bundle
and copy to the directory C:\Windows\PolicyDefinitions the chrome.admx file
located in the appropriate directory below:

for the 64 bit bundle:
\GoogleChromeEnterpriseBundle64\Configuration\admx

for the 32 bit bundle:
\GoogleChromeEnterpriseBundle\Configuration\admx

c. Navigate to the directory in which you extracted the Google Chrome Bundle
and copy to the directory C:\Windows\PolicyDefinitions\en-US the
chrome.adml file located in the appropriate directory below:

for the 64-bit bundle:
\GoogleChromeEnterpriseBundle64\Configuration\admx\en-US

for the 32-bit bundle:
\GoogleChromeEnterpriseBundle\Configuration\admx\en-US

Note: If a language other than en-US is desired, navigate to the appropriate language
directory within the admx directory, for example, for Spanish: es-ES, and copy to the
appropriate language directory within C:\Windows\PolicyDefinitions.

2. Create a Group Policy setting to deploy the Chrome extension
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a. Right-click Group Policy Objects, then select New to create a new GPO.
| & Group Policy Management Parent OU
v £\ Forest: Linked Group Policy
v &3 Domains _ .
This st does not inx
v 3
»./ AEG DB Firewall
=/ Default Domain Policy Precedence
:,,;_5 Map l*tlchvorlc Drive JA 1 (Enforcec
> 2. Domain Controllers & 2
v (3] Parent QU & 3
v g Child QU
», Default Domain Policy
v . GroupP '
| AEG
] Defa Back Up All...
] Defa Manage Backups...
& [.‘fnrr Open Migration Table Editor
(E] Firev
& Mac New Window from Here
i/ Map
i ou- Refresh
o smu Help

> _ WMI Filters

b. Enter a Name for the new GPO , then click OK.
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C. Right-click the GPO, and select Edit.

File Action View Help
oo 2nm = Bm
3 vetsocomebtensio- QY
« P Computer Configumtion Select an item to view its description.  Name
b [ Policies 1 Policies
p ) Preferences

418 UserConfiguation i
b ) Policies
b () Preferences

d. To force-install extensions, go to User Configuration\Administrative
Templates\Google\ Google Chrome\Extensions. Go to the setting Configure
the list of force-installed apps and extensions and double click it.
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File Action View Help
o 2m = Bm T

4 §& User Configuration Setting
4 (1] Policies 1] Blocks external extensions from being installed
p (] Software Settings iZ] Configure allowed app/extension types
b ] Windows Settings i Configure extension installation allow list
4 (1 Administrative Templates: Policy definitiont || '+ Configure edension installation blocklist
b [ Control Panel 5] Configure the list of force-installed apps and extensions Enabled
b (3 Desktop (2] Configure extension, app, and user script install sources
4 [ Google [£2) Control Manifest v2 extension availability

4 ] Google Chrome g i
[ Allow or deny screen capture (E] Bxension mansgement settings

) Content settings

] Default search provider
") Deprecated policies
] Extensions

] Google Cast

(] HTTP authentication
] Legacy Browser Support 1]
2] Microsoft® Active Directory® m
2 Native Messaging

] Network settings

[ Password manager

[ Printing

) Privacy Sandbox policies

) Remote access

e. Select the Enabled radio button.
f. Click the Show button.

g. In the Show Contents window, enter following string (this string points to
our extension in the Google web store) in the Value field:

Votiro CyberSec Ltd. Proprietary Page 119



V 0 T I R CJ 2 Using the Management Dashboard

jopliknbfkemjbgkoepoejcchliipoie;https://clients2.google.com/service/upd
ate2/crx

a Configure the list of force-installed apps and extensions — =l e

E Configure the list of force-installed apps and extensions Previous Setting l l Next Setting I

O Not Configured Comment: .

® Enabled o —

O Disabled B . e VContemsr : G |_| : - 2
Extension/App IDs and update URLS to be silently installed j

Options: » jopliknbfkemibgkoeposicchliipoie hitps://clients2 google com/service /update 2/cnx

Extension/App IDs an
installed

[ ok |[ Concel

his

list, Google Chrome automatically uninstalls it.

On Microsoft® Windows® instances, apps and extensions from
outside the Chrome Web Store can only be forced installed if the
instance is joined to a Microsoft® Active Directory® domain,
running on Windows 10 Pro, or enrolled in Chrome Browser
Cloud Management.

| ||
3. Import xml to the group policy (to update the registry)
a. Download and save the following xml file locally: tenantXchromePlugin.xml
b. Open the file for editing and update to match the relevant customer, as
following:
° hostname — The cluster you work with (i.e., ga.sg.paralus.votiro.com).
° isAudit — When the value is:
° true (1) - files are not sanitized, but still appear on our
Incidents page.
° false (0) - files are sanitized.
° isFailOpen — Fail-open and Fail-close error handling:
° isFailOpen = 1: In case of an error in Votiro, the original file

will be downloaded
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isFailOpen = 0: In case of an error in Votiro, the file will be not
downloaded.

Note:

When a change is made to the registry, the registry should be backed up and then
reloaded with the updated values.

votiroPolicyName — The policy that should be used in the server.

token — The service token for the relevant client (should be taken from

the Ul)
c. Save the file and close it.
d. Right-click the xml file in File Explorer and copy it to the Windows clipboard.
e. In the Group Policy Editor, navigate to Computer Configuration > Preferences

> Windows Settings > Registry.

f. Right-click the white pane on the right. In the context menu, select Paste (or
press CTRL+V if you don’t see the paste menu).

=/ Group Policy Management Editor - m] X
File Action View Help
e rEBmc HE RO +

(5] Hardening_Ciphers_2016 “mal y
v (& Computer Configuration
~| Policies
v || Preferences
v | Windows Settings
Environment
3"? Files
(¢ Folders
5] Ini Files

Order

Action Hive

[#] Shertcuts
(37 Control Panel Setting
v & User Configuration
| Policies

7| Preferences Description
No policies selected New
All Tasks >
Refresh
Export List...
A View >
£ > |\ Preferences f Extended )\‘Standard
Registry Arrange lcons >
Line up Icons
) Help
g. The Confirm Import window opens. Click Yes.
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Confirm Import

i Are you sure you want to import the pasted document?

Yes Ne

h. The GPO is created. Now you need to link it according to the organization’s
policy. Locate the OU or Domain you want to apply the GPO to, then right-
click it and select Link an Existing GPO.... Then select your GPO from the list,
and click OK.

Note: The policy contains both user configurations and computer configurations, so
make sure the policy is applied on both computers and users.

4, Verify the Browser Extension Deployment
a. Open the Chrome browser. The Votiro Chrome connector icon will be
displayed.

2 ®* 0 © 60 G

"VOTIRG seversusr

If the Votiro Chrome connector icon appears as above, each downloaded file
will be sanitized by Votiro.

b. If there was a problem, the Votiro Chrome connector icon will be displayed
as off:
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IQ ﬁ' ¢ p @ 8 [ll:

‘WVOTIRG sovserser

Manual Deployment

1. Install the extension from Google chrome web store

a. Go to the following link in Chrome: Votiro Chrome Connector

& chrome web store

Home > Extensions > Chrome Connector

( Chrome Connector

i d kA 0O | Productivity | 2users

b. Click on Add to Chrome. A confirmation window opens:

D Add "Chrome Connector”?

It can:
Read and change all your data on all websites
Manage your downloads

Know your email address

Add extension [ Cancel

c. Click on Add extension.

2. Configure the Browser Extension
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a. The Chrome connector icon will be displayed with the off icon.

2 % 0 ® 8 ™ O]l

d V 0 T I R CJ Browser plugin

b. Click on the “Settings” icon:

2 % 008 " Gl

| V OTI R D Browser plugin/ ﬂ

Hostname

{clusterName}.paralus votiro.com |

Token
' eyJhbGciOiJSUzI1NilsimtpZ CI61jVBQzg2MDVERD|

c. Copy and paste the Hostname and Token from the Votiro Management
console as in the above example.

d. Click on SAVE.

e. After saving, the Chrome connector extension will be activated. The Chrome

connector icon will not be displayed with the off icon.
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L2 * 0 0 6 G

"VOTIRG seversusr

If the Votiro Chrome connector icon appears as above, each downloaded file
will be sanitized by Votiro.

Download and Install in Microsoft Edge Browser

To deploy the Browser plugin in the Microsoft Edge browser:

1. Paste the Chrome store extension URL to the Microsoft Edge browser:
Votiro Browser Plugin

& @ M &~ VotiosowserPugin x [+ - o x
« C O h le.com/detail/votiro-t pluginjopliknbfkemjbgkoepoejcchliipoie a A % Mm B - O
Q
Votiro Browser Plugin works on Microsoft Edge
@
& chomewebstore  Discover  Extensions T hemes Q, Search extensions an d themes T om m i o
(@ Switch to Chrome to install extensions and themes ~ Instal Il Chrome
c, Votiro Browser Plugin
5.0 % (7 ratings)
Extension Workflow & Planning 350 users.
Some Threats You
Detect.
L]
Some You Don't.
We Stop Both.
Make Incoming Files Safe. At Scale. Instantly. Jd®
2. Click the Get extension or Get button to install.

Allow extensions from other stores

Microsoft does not verify extensions installed from third-party stores. To get
extensions verified by Microsoft, go to the Microsoft Edge add-ons website.

3. Click the Allow button.
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D Add "Votiro Browser Plugin” to Microsoft Edge?

The extension can:

+ Read and change all your data on all websites

» Manage your downloads
+ See your email address
» Manage your apps, extensions, and themes

Click the Add extension button. The Votiro Browser Plugin is installed.

X

Votiro Browser Plugin has been added
to Microsoft Edge

- Manage your extensions by clicking
Settings and more > Extensions.

Download and Install in Cyberark Secure Browser

To deploy the Browser plugin in the Cyberark Secure Browser:

1.

Deploy the Browser plugin to Chrome using the appropriate deployment procedure
(centralized or manual).

Open and authenticate to the Cyberark Secure Browser.

Navigate to the CyberArk User Portal and add the Votiro Browser plugin to the
Applications.

Enter the Hostname for the cluster you work with.

Enter the Token generated using the procedure described in Service Tokens.
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b

VOTIRG e

L ®

All ltems Hotwme | 6 S
All  Applications  Secured items = FEE
B Allitems — @ & : -:-
3 oevices Amazon.com UPS CampusShip Sslesforce Confluence AL
A~ Activity L] L -]
@ oninenep
4. After the plugin is successfully installed and configured, you can test file downloads.
You can see threat detection history by clicking Votiro’s plugin.
€ User boral x|+ P
« C @ 23t4387.my.idaptive.app/my#/MyApp VRhYjphcHBsaWNhAGIvbnM = e %« 609 »0a
VOTIRG -oa
All Items ViewinlegacyUl | (®) admi

@ CYBERARK

ality Demonstration.

E

ANl Applications  Secured items Img”m

@ User Portal - . = . o threats wese fon
2 Anitems s @ L & : &
@ oeviees amazon.com s Confluence NTLM and Bas
@ oninehen

Post-Deployment Actions

Enable Downloads

In the Chrome browser:

1. Navigate to Extensions > Manage Extensions, or enter chrome://extensions in the
address box.

2. Navigate to Votiro Plugin Details in Manage extensions.

3. Scroll down, and enable the following:
Check Allow access to file URLs.

Check Allow in Incognito.
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